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Thank you for purchasing RM-64/RM-25/RM-9 Network Video Recording Software (hereafter referred to as “RM-64/25/9” or 
“this software”).
This manual also explains how to use RM-Lite v1.1 Network Video Recording Software (hereafter referred to as “RM-Lite”). 
For the difference between RM-64/25/9 and RM-Lite, see “About RM-Lite” (p. 28).
Please read this manual before using the software. After reading this manual, keep it in a safe place for future reference.
In addition, please read the license agreement before using the software. The license agreement can be found in the 
LICENSE folder on the setup CD-ROM.

Request to Customers
1. Canon owns the copyright of this manual. The unauthorized transfer of all or any part of the contents of this manual is 

forbidden.
2. The contents of this manual are subject to change without notice.
3. This document has been prepared with the utmost attention to accuracy. However, if you have any comments, please 

contact the Customer Service Center indicated on the back cover.
4. Irrespective of items (2) and (3) above, Canon cannot bear responsibility for any effects resulting from operation.
5. Control Panel procedures described in this manual use the Windows 7 Basic display theme.

Disclaimer
Malfunction and failure of this software, or other factors may cause problems, such as recording failure, recorded data 
corruption or data loss. Canon shall have no liability whatsoever for any loss or damages incurred by the user as a result of 
such problems. Please use this software with this understanding.

Support Information

For support information, including software updates (patch installer), user manuals, and operating environments, see the 
Canon Web site.

Copyright Information

Videos, images or sounds recorded with your camera may not be utilized or published, without the consent of the copyright 
holders, if any, except in such a way as permitted for personal use under the relevant copyright law.

Trademark notices

• Canon and the Canon logo are registered trademarks of Canon Inc.
• Microsoft, Windows, Windows Server, Windows Vista, Internet Explorer, SQL Server and Visual C++ are registered 

trademarks or trademarks of Microsoft Corporation in the United States and other countries.
• Windows is legally recognized as Microsoft Windows Operating System.
• QuickTime is a trademark of Apple Inc.
• Apache is a trademark of the Apache Software Foundation.
• Pentium, Intel Core and Xeon are trademarks of Intel Corporation in the United States or other countries (or both).
• NVIDIA and GeForce are registered trademarks or trademarks of NVIDIA Corporation in the United States and other 

countries.
• Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their 

respective owners.
• All other company or product names used in this manual are trademarks or registered trademarks of their respective 

holders.
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NOTICE ABOUT THE MPEG-4 VISUAL STANDARD
THIS PRODUCT IS LICENSED FROM MPEGLA, LLC. UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR 
THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO (i) ENCODING VIDEO IN COMPLIANCE WITH THE 
MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A 
CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY. NO LICENSE IS GRANTED OR SHALL BE 
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, 
INTERNAL AND COMMERCIAL USES AND ADDITIONAL LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

This product is licensed under AT&T patents for the MPEG-4 standard and may be used for encoding MPEG-4 compliant 
video and/or decoding MPEG-4 compliant video that was encoded only (1) for a personal and non-commercial purpose or 
(2) by a video provider licensed under the AT&T patents to provide MPEG-4 compliant video. No license is granted or 
implied for any other use for MPEG-4 standard.
(Notice displayed in English as required.)

About Third Party Software
This product contains third party software modules.
Each module’s license conditions are also available in the OpenSourceSoftware folder in the LICENSE folder on the 
accompanying set-up CD-ROM.
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This product has the following manuals:
• Administrator’s Manual (this guide)

This manual is intended for the system administrator and provides information on how to operate this software product.
• Viewer Operation Guide

This simplified manual is intended for general users and explains how to operate the Viewer.
Please also read the manuals provided with each camera, as required.

About Sample Screens Unique to This Software

In this manual, some screens that are unique to this software are used as examples to illustrate operations. Please note that 
they may differ from the actual screens.
The VB-M40 is mainly used as the example camera in this manual. In addition, screens from Windows 7 are used as 
samples to describe operations.

How to Display and Read This Manual

This manual assumes that you display and read it on your computer’s screen.

Icons in This Manual

The following icons indicate descriptions you should pay close attention to.

Icons Indicating Camera Models

The following icons indicate information unique to that camera model.

About the Manuals

Icon Meaning

Important Cautions and restrictions during operation. Make sure to read these carefully.

Note Supplementary descriptions and reference information.

Hint Information useful for operation.

Icon Camera Model

VB-M700F

VB-M600D and VB-M600VE

VB-M40

VB-C500VD and VB-C500D

VB-C60

VB-C300

VB-C50Fi and VB-C50FSi

VB-C50i and VB-C50iR



About the Manuals
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Icons Indicating Products

The following icons indicate information that is unique to the full product and the Lite version.

Icon Meaning

Features unique to the RM-64/25/9. They cannot be used with RM-Lite. 

Information unique to RM-Lite. 
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The RM series of network video recording software is a 
software product family used to monitor multiple locations 
using network cameras and to record and play back 
images from the cameras. It is possible to set up a 
monitoring system with a maximum of 64 cameras (when 
using RM-64).

Flexible screen layout
You can arrange multiple video windows in the Viewer, so 
you can compare images from different locations at the 
same time. The Viewer lets you create multiple layouts 
and organize them in tabs on the viewing area, so you can 
easily switch between different camera images. You can 
also operate up to two Viewers at the same time. With an 
environment that supports multiple displays, you can 
create a dual-display monitoring setup by locating a 
Viewer on each of the displays.

Multiple recording modes
In addition to being able to record images for a specific 
period, you also have recording modes, such as sensor 
recording, motion detection recording, intelligent function 
recording and volume detection recording, which start 
recording when a particular type of camera event occurs.

Support for JPEG/MPEG-4 and H.264*
The JPEG, MPEG-4 and H.264 video formats are 
supported for live view and recording. Using MPEG-4 or 
H.264 formats decreases the load on the network 
bandwidth, while maintaining high quality video and 
saving hard disk space when recording.

* Only available for cameras that support the feature.

Dynamic layout
With this feature, you can automatically display videos on 
a layout from cameras that meet specific criteria, such as 
the camera status.

Direct camera operation*
You can change the camera angle and use the zoom 
while watching the live view.

* Only available for cameras that support the feature.

Camera tags
You can assign tags to a camera that give you information 
about the camera, such as its location and camera type. 
This is particularly useful when searching for cameras in a 
large-scale system.

User access management with user groups
You can create user groups to more easily manage user 
access. By assigning permissions for Viewer functionality 
to a group, you automatically assign the same 
permissions to each member of the group.

Shade control
Shade control automatically compensates for the dark 
regions in the image and can be used for both live and 
recorded images.

Two-way audio
Send and receive live audio and simultaneously record 
audio with the image. You can also use this feature to 
communicate with a location that has a camera.

Record Now
Use this feature to immediately start recording when you 
do not have a recording schedule set up.

Saving a segment of a recording
You can extract part of a recording and save it as a video 
file that can be played on a computer.

Some features have limited functionality. For details, 
see “About RM-Lite” (p. 28).

Features
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The flow from preparation before introducing the system, to operation management and maintenance is shown below.

Setup Flow

Step 1 Consider the video storage period and recording conditions, determine 
the hard disk capacity required for recording and prepare the 
equipment.
See “System Design” in Chapter 1: Introduction.

Prepare for introducing the system

Step 2 Set up your cameras for live image display or recording.
See your camera manuals.

Set up your cameras

Step 3 Install this software product on your computer.
See Chapter 2: Setup.

Install

Step 4 Set up the Storage Server Group and Storage Servers.
See Chapter 3: Storage Server Settings.

Set up the Storage Servers

Step 5 Add cameras to the Storage Server Groups.
See Chapter 3: Storage Server Settings.

Add cameras

Step 6 Configure the Viewer to match your environment and use.
See Chapter 4: Viewer Settings.

Configure the Viewer

Step 7 Set the recording conditions for using the cameras, including regular 
recording and motion detection recording.
See Chapter 5: Setting a Recording Schedule.Set a recording schedule

Step 8 Control cameras while viewing live images, check events, and play 
back recorded images. You can set up your own layouts for the video 
windows.
See Chapter 6: Day-to-Day Operations.

Day-to-day operation

Step 9 We recommend that you set up a management and maintenance 
process, such as taking regular backups of recording files, to reduce 
the impact of network failures on system operation. 
See Chapter 7: Operation and Management and Chapter 8: 
Backup.

Operation management and 
maintenance



8

Contents

About the Manuals ...................................................................................................... 4

About Sample Screens Unique to This Software .................................................................. 4

How to Display and Read This Manual................................................................................. 4

Features ...................................................................................................................... 6

Setup Flow .................................................................................................................. 7

Chapter 1 Introduction
Operating Environment ............................................................................................. 14

For High-reliability/H.264 Video Format Systems ............................................................... 14

For Small-scale Systems (Both Storage Server and Viewer Installed) ............................... 16

Important Notes Concerning System Requirements .......................................................... 17

Additional Considerations................................................................................................... 18

Supported Cameras .................................................................................................. 18

Product Type and Number of Licenses ..................................................................... 18

About Licenses ................................................................................................................... 19

Maximum System Configuration ......................................................................................... 19

Notes on the Software......................................................................................................... 19

System Configuration Example ................................................................................. 20

Configuration Example 1: Storage Server and Viewer Installed on One Computer ........... 20

Configuration Example 2: Storage Server and Viewers Installed on 

Multiple Networked Computers .......................................................................................... 21

Configuration Example 3: Viewers Installed on Multiple Networked Computers................ 21

System Design .......................................................................................................... 22

Determining the Capacity of the Storage Server ................................................................ 22

Sensor Recording, Motion Detection Recording, Intelligent Function Recording and 

Volume Detection Recording .............................................................................................. 26

Calculating Network Bandwidth.......................................................................................... 27

About RM-Lite ........................................................................................................... 28

Chapter 2 Setup
Installation ................................................................................................................. 32

Before Installation ............................................................................................................... 32

How to Install the Software.................................................................................................. 32

Settings After Installation........................................................................................... 34

Windows Firewall Settings .................................................................................................. 34

Security Level Setting ......................................................................................................... 35

Sound Settings for Using the Audio Feature....................................................................... 35

Warning When Viewer Starts............................................................................................... 35



Contents

9

Chapter 3 Storage Server Settings
Flow of Storage Server Settings................................................................................ 38

Start the Viewer......................................................................................................... 39

Configure a Storage Server Group............................................................................ 41

Display the [Storage Server Group Settings] Dialog Box ................................................... 41

Change the Storage Server Group Name........................................................................... 41

Configure the Recording Settings....................................................................................... 41

Configure Event Priorities and E-mail Notifications............................................................. 42

Configure a Storage Server....................................................................................... 45

Display the [Servers] Tab ................................................................................................... 45

Change the Destination of the Recording File and the Maximum Disk Usage................... 46

Add a Camera ........................................................................................................... 47

Display the [Cameras] Tab................................................................................................. 47

Add Cameras One at a Time .............................................................................................. 47

Assign Camera Tags .......................................................................................................... 48

Search For and Add Cameras ............................................................................................ 48

Edit Camera Information ..................................................................................................... 49

Remove a Camera .............................................................................................................. 50

Add a User ................................................................................................................ 51

About User Groups ............................................................................................................. 51

Display the [Users] Tab ...................................................................................................... 51

Add a User.......................................................................................................................... 52

Change the User Information.............................................................................................. 52

Remove a User ................................................................................................................... 53

Add a User Group and Specify Its Access Permissions .................................................... 53

Chapter 4 Viewer Settings
Flow for Viewer Settings............................................................................................ 56

Configure the Viewer................................................................................................. 57

Display the [Viewer Settings] dialog box ............................................................................ 57

Configure the Viewer Display and Operation Settings ....................................................... 57

Configure Event Notification and Priorities ......................................................................... 58

Configure the Display/Hide Mode for Each Event .............................................................. 58

Configure the Camera ............................................................................................... 59

Display the [Camera Selector] dialog box.......................................................................... 59

Select a Camera ................................................................................................................. 59

Configure the Video Window .............................................................................................. 60

Configure the [Advanced Camera Settings]....................................................................... 61

Configure the Video Window Layout ......................................................................... 65

Create a Layout................................................................................................................... 65

Place a Video Window ........................................................................................................ 66

Save the Layout .................................................................................................................. 67

Configure a Dynamic Layout .............................................................................................. 67

Switch Between Layouts ..................................................................................................... 68

Open Multiple Layouts Using Tabs..................................................................................... 68

Organize Layouts................................................................................................................ 69



10

Chapter 5 Setting a Recording Schedule
Flow of Recording Schedule Settings ....................................................................... 72

Record on a Regular Basis (Repeating Weekly Schedules) ..................................... 73

Display the [Recording Schedules] window....................................................................... 73

Select a Camera ................................................................................................................. 73

Set a Weekly Schedule ....................................................................................................... 74

Specify the Recording Period and Day of the Week .......................................................... 74

Specify the Recording Mode .............................................................................................. 75

Specify Advanced Settings................................................................................................. 75

Save the Recording Schedule ............................................................................................ 75

Configure the Recording Mode .......................................................................................... 76

Configure the Advanced Recording Settings ..................................................................... 82

Record at Specific Times (Special Day Schedule Settings)...................................... 88

Display the [Special Day Schedules] Tab .......................................................................... 88

Create a Special Day Schedule.......................................................................................... 88

Specify the Day for the Special Day Schedule ................................................................... 89

Select a Camera ................................................................................................................. 89

Specify the Recording Settings .......................................................................................... 89

Edit a Recording Schedule........................................................................................ 90

Editing a Recording Schedule ............................................................................................ 90

Delete a Recording Schedule............................................................................................. 90

Import from a Weekly Schedule.......................................................................................... 90

Chapter 6 Day-to-Day Operations
Flow of Operations .................................................................................................... 94

Viewer Features ........................................................................................................ 95

View Recorded Images ............................................................................................. 96

Record Now ........................................................................................................................ 96

Save a Snapshot of the Displayed Image........................................................................... 96

Search for a Recording....................................................................................................... 97

Play a Recording................................................................................................................. 98

Zoom the Viewing Area In and Out..................................................................................... 99

Save Part of a Recording .................................................................................................... 99

Operate the Camera................................................................................................ 100

Get Control of a Camera ................................................................................................... 100

Use the Pan/Tilt/Zoom Feature.......................................................................................... 100

Change the Camera Angle to a Preset Position ............................................................... 101

Change the Camera Angle Using a Panorama Image ..................................................... 102

Play Back Audio................................................................................................................ 102

Compensate for Dark Regions in the Image..................................................................... 103

Check Events .......................................................................................................... 104

View a Live Event .............................................................................................................. 104

Search for Events.............................................................................................................. 105



Contents

11

Chapter 7 Operation and Management
Storage Server Health Check.................................................................................. 108

Events Indicating Errors or Warning Levels and Corresponding Actions ........................ 108

Status Bar.......................................................................................................................... 109

System Information ........................................................................................................... 109

Disk Space Management (Important)...................................................................... 110

Chapter 8 Backup
Backing up data....................................................................................................... 114

Destinations of the Backup Files....................................................................................... 114

Notes on Backup .............................................................................................................. 114

How to Restore a Backup........................................................................................ 115

Restoring from Backup Data............................................................................................. 115

Chapter 9 Troubleshooting
Actions Required When Recording Errors Occur.................................................... 118

Solutions When Viewer Problems Occur ................................................................ 118

Viewer and Video windows............................................................................................... 118

Timeline............................................................................................................................. 120

[Extract Video] .................................................................................................................. 120

Recording ......................................................................................................................... 120

Connection Problems........................................................................................................ 120

Error Messages ....................................................................................................... 121

Messages Displayed in the Viewer................................................................................... 121

Messages Recorded in the Log Files ............................................................................... 125

Event Information .................................................................................................... 128

Appendix
Create a Shortcut Icon for Starting the Viewer........................................................ 130

Camera Maintenance .............................................................................................. 130

About the Latest Camera Firmware .................................................................................. 130

Update the Firmware ........................................................................................................ 130

How to Check the Version....................................................................................... 131

Checking the Version of the Viewer .................................................................................. 131

Checking the Version of the Storage Server..................................................................... 131

Functional Limitations for MPEG-4 and H.264 formats ........................................... 131

Using the AXIS Q7404/Q7401 ................................................................................ 132

Supported Firmware ......................................................................................................... 132

Usage Precautions............................................................................................................ 132

Functional Limitations ....................................................................................................... 132

Index........................................................................................................................ 134



12



Chapter 1
Introduction

❏ System requirements (operating environment, supported cameras, license conditions)

❏ System configuration and design guidelines

❏ RM-Lite specification comparison



14

For High-reliability/H.264 Video Format Systems

Operating Environment

Storage Server Viewer

CPU Intel Xeon 3060, Intel Core 2 Duo 2.4 GHz or 
higher, or an Intel CPU of equivalent class that 
meets the following requirements:
Clock: 2.4 GHz or higher
L2 cache: 4 MB or greater
Number of cores: 2 or more

Intel Core i5 750 2.67 GHz or higher 

Memory 2 GB or greater

Hard disk Interface: SAS / SATA
Cache: 16 MB or greater
Spindle speed: 7200 rpm or faster
100 MB is required for installation (an additional 
500 MB is required if .NET Framework 3.5 SP1 is 
not installed)
Additional space for recording files and other files 
(the actual space required depends on the 
number of cameras and the recording settings)
We recommend that you use separate hard disk 
drives for the OS and the recording data.
The hard disk drive for the recording data should 
have a capacity of 1 GB or greater.

100 MB is required for installation (an additional 
500 MB is required if .NET Framework 3.5 SP1 is 
not installed)
Additional space for saving extracted video files, 
as required.

Network controller 1000 BASE-T or similar, 1 Gbps transfer speed

Display — 1280 × 1024 resolution or higher
16-bit colors or greater

Graphics — NVIDIA GeForce GT 220 or higher, or a graphics 
card of equivalent class that meets the following 
requirements:
Video memory size: 1 GB or greater
Memory interface width: 128-bit or larger
Memory clock: 790 MHz or higher

Others — Audio support is required for audio playback 
(p. 102).

Operating system Windows Server 2008 Standard Edition (Service Pack 2) 32-bit or 64-bit version
Windows Server 2008 R2 Standard Edition (Service Pack 1) 64-bit version
Windows Vista Ultimate/Business/Enterprise (Service Pack 2) 32-bit or 64-bit version

Windows Vista Home Premium (Service Pack 2) 32-bit or 64-bit version
Windows 7 Ultimate/Professional/Enterprise (Service Pack 1) 32-bit or 64-bit version

Windows 7 Home Premium (Service Pack 1) 32-bit or 64-bit version

Language support Japanese, English, French, German, Italian, and Spanish
Multi-Language Windows is not supported.
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Introduction

1
Important

• The system requirements described above are the minimum configuration, assuming the following operating environment:

• If you need to operate a high-reliability system (such as for 24-hour operation) in a system environment, we recommend that you use a 
server operating system on the computer that is used for the Storage Server.

• When high-reliability operation is required (such as for 24-hour operation, and high frequency disk access) we strongly recommend 
that you use a high-reliability SAS hard disk. Using a low-reliability SATA hard disk may result in a disk error in a one to two year period. 
Therefore, you may need to check the disk for errors on a regular basis, using features such as scan disk. In such a case, recording 
performance may suffer during checking, due to the increased load on the disk.

• With systems intended for users requiring high-reliability/H.264, when operating both the Storage Server and the Viewer on one 
computer, the operating environment must satisfy the requirements for both the Storage Server and the Viewer. However, to help 
ensure stable operation, we recommend that you use separate computers for the Storage Server and for the Viewer.

*1Number of cameras selected in [Motion Detection Using]>[Storage Server] for motion detection recording.

*2Total number of all types of events.

*3Assumes a standard resolution ([Image Quality] setting is [3]) and that the receive size and display size are the same. If the receive 
size and display size are different, performance may decrease due to an increase in processing load.

*4 If multiple image sizes are combined on a system, the equivalent sizes are four 320 x 240 images for 640 x 480, and eight 320 x 240 
images for 1280 x 960. For example:

*5The number of videos you can display at once depends on the amount of memory available. If there is not enough memory, you will 
not be able to display videos.

Storage Server Maximum recording/playback data rate 80 Mbps

Overall recording frame rate 1280 fps or slower (640 fps or slower when 
recording audio)

Maximum number of cameras with motion 
detection *1

10

Maximum events processed *2 20,000 events per day

Viewer Estimated display frame rate *3 1280 x 960: 40 fps *4

640 x 480: 80 fps *4

320 x 240: 320 fps

Total number of simultaneously displayable 
MPEG-4 and H.264 videos

6 or less*5 

1280 x 960 (10 fps) equivalent to 80 fps (10 fps x 8)

640 x 480 (20 fps) equivalent to 80 fps (20 fps x 4)

320 x 240 (160 fps) 160 fps (same as original)

Total of 320 fps (80 + 80 + 160)
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For Small-scale Systems (Both Storage Server and Viewer Installed)

Storage Server

CPU Intel Pentium G6950 2.80 GHz or higher, or an Intel CPU of equivalent class that meets the following 
requirements:
Clock: 2.4 GHz or greater
L2 cache: 512 KB or greater
L3 cache: 3 MB or higher (only required if the L2 cache is less than 3 MB)
Number of cores: 2 or more

Memory 2 GB or greater

Hard disk Interface: SAS / SATA
Cache:16 MB or greater
Spindle speed: 7200 rpm or faster
200 MB is required for installation (an additional 500 MB is required if .NET Framework 3.5 SP1 is not 
installed)
Additional space for recording files and other files (the actual space required depends on the number 
of cameras and the recording settings)
Additional space for saving extracted video files, as required.
The hard disk drive for the recording data should have a capacity of 1 GB or greater.

Network controller 100 BASE-TX or similar, 100 Mbps transfer speed

Display 1280 × 1024 resolution or higher
16-bit colors or greater

Others Audio support is required for audio playback (p. 102).

Operating system Windows Server 2008 Standard Edition (Service Pack 2) 32-bit or 64-bit version
Windows Server 2008 R2 Standard Edition (Service Pack 1) 64-bit version
Windows Vista Ultimate/Business/Enterprise (Service Pack 2) 32-bit or 64-bit version

Windows Vista Home Premium (Service Pack 2) 32-bit or 64-bit version
Windows 7 Ultimate/Professional/Enterprise (Service Pack 1) 32-bit or 64-bit version

Windows 7 Home Premium (Service Pack 1) 32-bit or 64-bit version

Language support Japanese, English, French, German, Italian, and Spanish
Multi-Language Windows is not supported.

Important

• The system requirements described above are the minimum configuration, assuming the following operating environment:

*1Do not use H.264 in small-scale systems, as this can have a negative effect on system operation.

*2Total number of all types of events.

*3Assumes a standard resolution ([Image Quality] setting is [3]) and that the receive size and display size are the same. If the receive 
size and display size are different, performance may decrease due to an increase in processing load.

*4The number of videos you can display at once depends on the amount of memory available. If there is not enough memory, you will 
not be able to display videos.

Storage Server Maximum recording/playback data rate 16 Mbps *1

Recording frame rate 256 fps or slower (128 fps or slower when 
recording audio)

Maximum number of cameras with motion 
detection

0

Maximum events processed *2 10,000 events per day

Viewer Estimated display frame rate *3 1280 x 960: 2 fps

640 x 480: 10 fps

320 x 240: 30 fps

Total number of simultaneously displayable 
MPEG-4 and H.264 videos

6 or less*4
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Introduction

1

Important Notes Concerning System Requirements

• This software does not support external storage, such as USB hard disks and NAS.
• We recommend that you operate this software in its own dedicated LAN environment.
• The software may not be able to record images if you use an environment where the IP addresses of the cameras are 

occasionally changed. Use fixed IP addresses to ensure proper operation.
• Be sure to operate the cameras, Storage Servers and Viewers over networks using the same network protocol (e.g. all 

over IPv4 networks, or all over IPv6 networks).
• For details on the operating system, see “Additional Considerations” in “Operating Environment” (p. 18).
• Audio cannot be transmitted from a Viewer if you use the Viewer on a computer running Windows 7 or Windows 

Server 2008 R2.
• Before applying a service pack or updating the operating system, please refer to Canon’s compatibility information.
• Running Windows Update may cause system operation to become unstable and cause the system to restart.
• Using anti-virus software or a firewall may affect the performance of the Storage Server and Viewer.
• Running software other than this product or compatible camera management software may cause system operation to 

become unstable.
• When there is a high load on the CPU or hard disk, images may not be recorded or displayed at the specified frame rate, 

recording may be interrupted, or the Viewer operation speed may decrease. In addition, recording may be interrupted 
when the available hard disk space is low.

• Operation may slow down if the amount of stored data (number of recording files) becomes large.
• Depending on the performance of the computer and the network environment, changes in the recording environment 

(such as the time of day and the weather) may result in it not being possible to display recorded or live images according 
to the specified settings.

• Using IPsec may degrade the performance for recording and displaying images.
• You can use the camera audio feature (except for the VB-C50Fi, which does not support the function). Review the 

following items before using the feature.
– The Viewer supports transmission and reception of audio data.
– Audio data cannot be recorded separately, and is always recorded together with the images.
– Synchronization is enabled only when playing back recorded images (JPEG) and recorded audio. However, the audio 

and images may not be synchronized, depending on the operating environment (p. 76).
– The audio stream may be interrupted, depending on the performance of your computer and network environment.
– Audio may be interrupted when using anti-virus software.

• Be sure to test the system under your operating environment before starting regular operation.

Note

• The system environment of the Storage Server will depend on your operating conditions (number of cameras, recording frame rate 
settings, etc.), as well as the pre-event recording settings. For details, contact your local supplier.

• Microsoft .NET Framework 3.5 SP1 is required for this software to operate. It is automatically installed when installing RM-64/25/9. For 
RM-Lite, install it from the included CD-ROM before installing RM-Lite.

• The following are guidelines for implementing a system for a small-scale user.

• The Viewer PC specifications on p. 14 are required even for small scale systems (up to four cameras) using RM-Lite, if you want 
to display multiple H.264 images in 1280 x 960 size.

System components Guideline

Number of cameras Approx. 9 cameras (assuming RM-9 is used for operation)

Recording frame rate 5 fps x 9 cameras with 320 x 240 standard resolution (approx. 8 Mbps in terms of data rate)

Live view frame rate 3 fps x 9 cameras ( = 27 fps) with 320 x 240 standard resolution

Playback 5 fps for each camera with 320 x 240 standard resolution
Maximum number of playable cameras:
Up to 6 (30 fps total) with a playback-dedicated layout
Up to 1 with the live view layout (see above) (3 fps x 8 live view cameras + 5 fps x 1 playback 
camera)

Others H.264 is not used
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• The following runtime modules are installed automatically with RM-64/25/9 and RM-Lite. Do not uninstall any of these modules.
– Microsoft Visual C++ 2008 Redistributable

• Microsoft .NET Framework 4.0 is not supported.

• The information in this guide is current as of February, 2012. For the latest information on this product, visit the Canon Web site.

Additional Considerations

• Do not specify the Windows folder or the Program Files folder on the system drive as the destination for snapshots or 
image files. You cannot save images or videos to those folders.

• You cannot use the shadow backup feature with this software. For example, once you delete the configuration file for this 
software, the file cannot be restored with the shadow backup feature.

Note
• See “Using the AXIS Q7404/Q7401” (p. 132) for details on limitations when using the AXIS Q7404/Q7401.

• The information in this guide is current as of February, 2012. For the latest information on this product, visit the Canon Web site.

The number of cameras that can be added to a Storage Server Group depends on the specific software product.
The following table describes the number of licenses required for servers and Viewers, as well as the number of Storage 
Servers that can be configured as a Storage Server Group, for each product.

Supported Cameras

Camera Firmware Version

VB-M700F Ver. 1.0.2 or later

VB-M600D Ver. 1.0.2 or later

VB-M600VE Ver. 1.0.2 or later

VB-M40 Ver. 1.0.2 or later

VB-C500VD/VB-C500D Ver. 1.1.0 or later

VB-C60 Ver. 1.1.0 or later

VB-C300 Ver. 1.1 Rev. 3 or later

VB-C50i/VB-C50iR Ver. 1.2 Rev. 77 or later

VB-C50FSi/VB-C50Fi Ver. 1.0 Rev. 77 or later

Product Type and Number of Licenses

Software 
product

Number of 
server 

licenses

Number of 
Storage Server 

Groups

Number of Storage Servers that can be 
configured as a Storage Server Group

Maximum number of cameras that 
can be added to a Storage Server 

Group

Number of 
Viewer 

licenses

RM-64 1 1 1 64 1

RM-25 1 1 1 25 1

RM-9 1 1 1 9 1

RM-Lite 1 1 1 4 1
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About Licenses

Each software product includes one license for the Storage Server and one license for the Viewer. The number of 
computers that a product with one license can be installed on is described below.

Storage Servers
One server license allows you to install one Storage Server on a computer.

Viewers
One Viewer license allows you to install one Viewer on a computer.
Up to 6 Viewers can connect to a Storage Server at one time.
You are able to purchase individual Viewer licenses, therefore you must purchase the same number of licenses as you have 
Viewer installations.

Maximum System Configuration

The following table describes the maximum system configuration supported by this software.

Notes on the Software

Compatibility with Network Video Recorder VK-64/16/Lite

Notes on Installation
This software cannot exist with VK-64/16/Lite on the same computer. Do not install this software onto a computer where 
VK-64/16/Lite is installed. You can install this software after uninstalling VK-64/16/Lite. However, please be aware of the 
following:
• You cannot use the cameras and recording schedule settings you added with VK-64/16/Lite. You must add and 

configure the cameras and schedules again.
• You cannot use the recording files and event information associated with VK-64/16/Lite.
• You cannot play back recordings made with VK-64/16/Lite.
• This software requires a computer with specifications that are higher than those required for VK-64/16/Lite. The computer 

used for VK-64/16/Lite may not meet the operation requirements for this software.

Notes on Protocol Compatibility
This software is not compatible with VK-64/16/Lite protocols, because the protocol used between the Viewer and the 
Storage Server has been significantly changed. Therefore, you cannot connect to a VK-64/16/Lite Storage Server from the 
Viewer in this software. Similarly, you cannot connect to this software’s Storage Server from the Viewer in VK-64/16/Lite.

Notes on Recording Data and Event Data Compatibility
This software uses event data and recording file formats that are different from VK-64/16/Lite. VK-64/16/Lite recordings can 
be played back using QuickTime Player. However, the recordings for this software are not supported by QuickTime Player. 
Note, however, that you can use QuickTime Player to play back a .mov file created using the [Extract Video] feature in this 
software.

Number of Storage Server Groups 1

Number of cameras Max. 64 (with RM-64)

Number of simultaneously connected Viewers Max. 6

Number of Storage Servers 1

Number of cameras that can be used by a Viewer Max. 64 (same as the max. number of cameras)

Number of camera images that can be simultaneously displayed by a Viewer Max. 64 
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This software records images from cameras using an IP network, such as a LAN.

Configuration Example 1: Storage Server and Viewer Installed on One Computer

This example shows the simplest system configuration, where the Storage Server and Viewer are installed on one computer. 
Images from the cameras are displayed or recorded using the same computer.

System Configuration Example

Important
• The load on the Storage Server may increase depending on the number of cameras connected and the recording settings. See 

“Determining the Capacity of the Storage Server” (p. 22) to consider your configuration.

• Accessing one camera or Storage Server from many Viewers at the same time may affect system performance.

• Regularly check that the time setting is correct on the computers that are running the Storage Server and the Viewer. Also, before 
changing the time setting on the computers, be sure to first stop the Storage Server and Viewer.

Storage Server Group

Network

Images from the cameras

Storage Server/Viewer
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Configuration Example 2: Storage Server and Viewers Installed on Multiple Networked 
Computers

You can install Storage Servers and Viewers on multiple computers on the network.

Configuration Example 3: Viewers Installed on Multiple Networked Computers
By setting up more than one Viewer, you can simultaneously view a video at more than one location.

Storage Server Group
Viewer

Network

Images from the cameras

Recorded images

Viewer 1

Network

Images from the cameras

Recorded images

Viewer 2
Storage Server Group

Viewer 6
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Determining the Capacity of the Storage Server

You must determine the configuration of your Storage Server based on the recording and playback data volume per second 
and the required hard disk capacity.

Recording / playback data volume per second and the audio data volume

If the volume per second of recording and playback data handled by one Storage Server is 80 Mbps or greater, you should 
review your recording requirements to ensure system stability. The following shows an estimate of the recording and 
playback data volume per second for various video formats.

*The JPEG video frame rate is based on an [Image Quality] setting of [3].
Audio data requires a Storage Server of 64 Kbps, regardless of the type of camera.

Hint

See “System Information” (p. 109) for details on the recording/playback data volume per second during operation.

System Design

Important

The operating performance of this software varies depending on factors such as the usage conditions and the hardware specifications of 
the Storage Server. Use the figures below only for reference.

320 x 240 640 x 480

JPEG* 580 fps 190 fps

MPEG-4
80 Mbps

H.264

Important

Depending on the hard disk and/or RAID card on your server, the disk write performance may be lower than the above estimates.
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Hard disk capacity requirements

It is assumed that you use continuous recording at a fixed frame rate (number of images per second), image size and 
quality. The size of the recording file varies depending on how the camera is configured (the settings for image quality and 
size) and the complexity of actual scene.

Follow these steps to determine the required hard disk capacity.

The higher the image quality setting, the higher the image quality and resulting data volume.

For general security purposes, you can use 1 to 2 fps. Higher frame rates require more hard disk space.

We recommend that you add 10 to 20% more space to the calculated hard disk capacity.

Sample calculations for each video format are shown below, assuming 1000 Kbps = 1 Mbps for the network bandwidth, 
and 1024 KB = 1 MB for the disk capacity.

Example 1: JPEG recording
• Image recording from 16 cameras (VB-C60)
• Image size is 320 x 240 and image quality is 3 (data size per frame: 12.5 KB)
• Recording frame rate is 2 fps
• Data size per second is approximately 25 KB (= 12.5 KB x 2 fps)

Although the actual recording file size depends on the objects recorded by each camera, this calculation assumes the 
typical sizes given above.

• Audio is recorded from 2 cameras
If JPEG images from 16 cameras are recorded at 2 frames per second in continuous recording mode, the required hard 
disk space is approximately 33 GB per day (= 25 KB x 16 cameras x 60 seconds x 60 minutes x 24 hours = 34,560,000 KB).
If audio data is recorded using 2 cameras, the required hard disk space is approximately 1.3 GB per day (= 8 KB x 
2 cameras x 60 seconds x 60 minutes x 24 hours = 1,382,400 KB).

Example 2: MPEG-4 recording
• Image recording from 8 cameras (VB-C60).
• Image size is 320 x 240 and image quality is 3.
• Recording frame rate is 30 fps.
• Data size per second is approximately 150 KB.

Although the actual recording file size depends on the objects recorded by each camera, this calculation assumes the 
typical sizes given above.

If MPEG-4 images from 8 cameras are recorded at 30 frames per second in continuous recording mode, the required hard 
disk space is approximately 99 GB per day (= 150 KB x 8 cameras x 60 seconds x 60 minutes x 24 hours = 10,368,000 KB).

1 Decide on the number of cameras and the image size for recording.

2 Decide on the image quality for each camera.

3 Decide on the frame rate required for recording.

4 Decide on the number of hours per day to record and the number of days to store the recorded data.

5 After deciding on the above parameters, calculate the required hard disk capacity based on the recording file size (in KB).

6 If you will also record audio, be sure to calculate the additional amount of hard disk space required for the audio.
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Example 3: H.264 recording
• Image recording from 8 cameras (VB-M40).
• Image size is 320 x 240 and image quality is 3.
• Recording frame rate is 30 fps.
• Data size per second is approximately 84 KB.

Although the actual recording file size depends on the objects recorded by each camera, this calculation assumes the 
typical sizes given above.

If H.264 images from 8 cameras are recorded at 30 frames per second in continuous recording mode, the required hard 
disk space is approximately 55 GB per day (= 84 KB x 8 cameras x 60 seconds x 60 minutes x 24 hours = 58,060,800 KB).

Note that the actual recording file size may be different from the size in the table, depending on the weather conditions and 
the complexity of the scene. For example, images of an empty corridor, would typically result in values smaller than the 
above values. Conversely, complex scenes, such as a crowded shopping mall, would result in larger values.

The following tables shows typical data sizes per frame (in KB) for various combinations of image quality and size settings.

Example of the Data Size for the VB-M700F/VB-M600D/VB-M600VE/VB-M40 (JPEG)

(Units: KB)

Example of the Bit Rate for the VB-M700F/VB-M600D/VB-M600VE/VB-M40 (H.264)

(Units: Mbps)

Image 
Quality

Image Size

160 × 120 320 × 240 640 × 480 1280 × 960

1 2.0 5.2 16.0 51.6

2 3.0 8.3 25.8 83.3

3 3.7 10.4 32.5 110.0

4 4.7 13.6 43.2 152.6

5 7.4 22.9 78.1 280.9

Image 
Quality

Image Size and Frame Rate

10 fps 15 fps 30 fps

320 × 240 640 × 480 1280 × 960 320 × 240 640 × 480 1280 × 960 320 × 240 640 × 480 1280 × 960

1 0.10 0.33 1.04 0.14 0.44 1.47 0.22 0.74 2.47

2 0.17 0.55 1.66 0.24 0.73 2.31 0.38 1.22 3.55

3 0.30 0.95 2.82 0.41 1.26 3.38 0.67 2.08 5.12

4 0.41 1.33 3.74 0.57 1.82 4.51 0.92 2.91 5.96

5 0.55 1.85 4.70 0.76 2.50 5.84 1.27 3.89 5.34
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Example of the Data Size for the VB-C500VD/VB-C500D/VB-C60 (JPEG)

(Unit: KB)

Example of the Bit Rate for the VB-C500VD/VB-C500D/VB-C60 (MPEG-4)

(Units: Mbps)

Note

The data size for MPEG-4 images may increase when recording images with quick movements.

Example of the Data Size for the VB-C300 (JPEG)

(Units: KB)

Image 
Quality

Image Size

160 × 120 320 × 240 640 × 480

1 3.5 9.6 27.5

2 4.0 11.0 31.7

3 4.4 12.5 35.8

4 5.6 16.4 47.8

5 15.8 52.7 171.4

Image 
Quality

Image Size and Frame Rate

10 fps 15 fps 30 fps

320 × 240 640 × 480 320 × 240 640 × 480 320 × 240 640 × 480

1 0.28 0.76 0.35 0.94 0.54 1.43

2 0.39 1.08 0.50 1.30 0.78 2.02

3 0.60 1.67 0.75 2.02 1.20 3.31

4 0.69 1.93 0.91 2.43 1.38 3.98

5 0.81 2.31 1.05 2.87 1.68 4.86

Image 
Quality

Image Size

160 × 120 320 × 240 640 × 480

1 3.2 8.8 24.2

2 3.7 10.2 28.3

3 4.1 11.5 32.0

4 5.3 15.4 43.2

5 15.5 52.8 170.6
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Example of the Data Size for the VB-C50i/VB-C50iR/VB-C50FSi (JPEG)

(Units: KB)

Note that the data size may increase significantly when the image quality is set to [100].

Select [View] > [Video Information] in the Viewer bundled with the camera to display the data size per frame.

Sensor Recording, Motion Detection Recording, Intelligent Function Recording and 
Volume Detection Recording

Notes on Using Sensor Recording, Motion Detection Recording, Intelligent Function Recording 
and Volume Detection Recording

When an event occurs, data is saved in the Storage Server as an operation record. As the number of operation records 
increases, operation during event detection and the search and Viewer response speeds may be affected.

Notes on Using Motion Detection Recording / Intelligent Function Recording

• The motion detection feature notifies you there is motion in an area when motion is not ordinarily expected. Do not use 
this feature for busy areas where motion detection may be triggered frequently.

• Configure motion detection on the camera side. If you configure motion detection on the Storage Server side, the load on 
the Storage Server may increase, resulting in decreased recording performance.

Use intelligent function recording instead of motion detection recording.

You cannot set motion detection on the camera.

Image 
Quality

Image Size

160 × 120 320 × 240 640 × 480

30 3.1 8.2 24.7

40 3.6 9.7 29.8

50 4.1 10.9 34.2

60 4.6 12.5 40.3

70 5.3 14.8 49.7

80 6.5 18.8 64.9

90 9.4 28.4 106.4

Important

The actual data size may increase or decrease depending on the objects being recorded. Make sure to confirm the data size for the 
actual system environment before starting operation.
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Notes on Storage Server Operation

We recommend that you dedicate the Storage Server computer exclusively to running this software.
Be sure to avoid the following on the Storage Server computer:

• Running Web server software on the computer
You cannot operate the Storage Server on a computer where Web server software such as Windows standard IIS 
(Internet Information Server) or Apache is already installed.
The Storage Server uses HTTP protocol to communicate with cameras. Therefore, the Storage Server may not work 
normally if other Web service applications exist on the same computer.
The HTTP port used by this software is 80 and cannot be changed.

• Running database server software (e.g., SQL Server, Oracle) on the computer
Database processing can place a load on the hard disk that may affect recording performance. Conversely, this 
software may affect database server performance when it performs tasks that place a load on the hard disk.

• Using the computer as a file server
The hard disk is frequently accessed when the computer is used as a file server, and this may affect recording 
performance. In addition, the Storage Server is more likely to run out of disk capacity if the computer is operated as a file 
server.

• Running other applications on the computer
The additional processing load from running applications other than this software may affect recording performance.
This software uses the TCP port numbers 80, 443, 11080 and 2380. These ports should not be used by other 
applications.

Calculating Network Bandwidth

You need to consider the network bandwidth if you want to use a network camera for both recording and live view.
You must calculate the network bandwidth both for the Storage Server and the Viewer.
When using the VB-M40 for example, calculate the bandwidth as follows if you use one Storage Server (320 x 240 1 fps) 
and two Viewers (320 x 240 5 fps):

• Bandwidth for recording
10.4 (KB/frame) x 1 (frames/sec.) x 8 (bits) = 83.2 Kbps

• Bandwidth for live view (per Viewer)
10.4 (KB/frame) x 5 (frames/sec.) x 8 (bits) = 416 Kbps

Therefore, the required network bandwidth is calculated as follows:
83.2 Kbps x 1 + 416 Kbps x 2 = 915.2 Kbps (approx. 0.9 Mbps)
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RM-Lite is a simpler version of this software that is bundled with the camera. RM-Lite provides the same basic features as 
the RM-64/25/9 product versions, but some of the functionality has be limited, as described below:

Functional limitations for RM-Lite
• You can add a maximum of four cameras.
• You can display a maximum of eight video windows in the Viewer. A warning message is displayed if you display nine or 

more video windows.
• The maximum frame rate is as follows:

Recording 5 fps or lower (JPEG)
Record Now 5 fps

• The frame rate adjustment feature is always enabled under high load.
• The maximum file size is 1 GB (max. 24 hours).
• You cannot change the [Background] property in the [Layout] properties, and live view is the only playback option.
• You cannot configure the “Organize Layouts” [Each Tag], [All Cameras] and [Recording Cameras].
• AXIS Q7404/Q7401 is not supported.

Features that cannot be used in RM-Lite

Storage Server
• MPEG-4 and H.264 recording
• Motion detection recording
• Sensor recording
• Intelligent function recording
• Volume detection recording
• Special Day schedule recording
• Sending e-mail when an event occurs
• Customizing event priority
• Adding user groups and configuring access permissions

Viewer
• Multiple display support
• Layout sequences
• Display of multiple tabs
• Custom grid
• Dynamic layouts
• Searching using camera tags
• Advanced search feature of Event Search
• Event Notification - Operator Notification, Acknowledge Event
• Display of a video window when an event occurs.

RM-Lite is not bundled with the camera.

About RM-Lite

Important
• You cannot install RM-Lite and RM-64/25/9 onto the same computer. Settings also cannot be transferred between the applications. You 

will need to redo the settings after an install.

• Files recorded with RM-Lite cannot be played back with RM-64/25/9. Similarly, files recorded with RM-64/25/9 cannot be played back 
with RM-Lite.

• An RM-Lite viewer cannot connect to an RM-64/25/9 Storage Server. Similarly, An RM-64/25/9 viewer cannot connect to an RM-Lite 
Storage Server.
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Specification comparison for RM-64/25/9 and RM-Lite

*1 The operational limits depend on factors, such as the number of cameras, Storage Server performance, hard disk 
capacity, and network load.

*2 The layout sequence feature is a function for changing Viewer layouts at a specified interval.

Features RM-64/25/9 RM-Lite

Connection to camera Max. number of cameras 64/25/9 4

Supported cameras VB-M700F, VB-M600D, 
VB-M600VE, VB-M40, VB-C500VD, 
VB-C500D, VB-C60, VB-C300, 
VB-C50Fi, VB-C50FSi, VB-C50i, 
VB-C50iR, AXIS Q7404/Q7401

VB-M700F, VB-M600D, 
VB-M600VE, VB-M40, VB-C500VD, 
VB-C500D, VB-C60, VB-C300, 
VB-C50Fi, VB-C50FSi, VB-C50i, 
VB-C50iR

Automatic camera search Yes

Storage Server Recording formats JPEG, MPEG-4, H.264 JPEG only

Max. recording frame rate 30 fps *1 5 fps

Recording schedule Weekly schedule recording
Special Day schedule recording

Weekly schedule recording

Recording mode Continuous recording
Sensor recording
Motion detection recording
Intelligent function recording
Volume detection recording
Manual recording (Record Now)

Continuous recording
Manual recording (Record Now)

Max. file size setting Configurable 512 or 1024 MB, 1 to 
24 hours (default: 1024 MB)

Fixed 1 GB (1024 MB), 24 hours

Max. storage period 99 weeks 90 days (12 weeks)

Others — The following features are not 
supported:
• Sending e-mail when an event 

occurs
• Customizing event priority

Viewer Supported live view formats JPEG, MPEG-4, H.264

Max. display frame rate 30 fps *1

Multiple display support Yes No

Number of simultaneous video 
windows

32 or fewer per layout 8 or less is recommended.

Audio recording/playback Yes

Layout sequence feature *2 Yes No
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Chapter 2
Setup

❏ How to install the software

❏ Settings after installation
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Before Installation

About Licenses
You must have one license per installed computer.
To add Viewers, you must purchase the required number 
of licenses separately (p. 18).

Use an NTFS Formatted Drive
The drive you install the software on and the drive for 
saving recorded images must be in NTFS format.

Set Up the Cameras
You must set up any cameras that you will use with this 
software before starting operation. For details, refer to the 
camera manual.

Stop Other Applications
Stop other applications that are running on the computer, 
such as anti-virus software, before installing the software.

How to Install the Software

This starts the installer automatically. If the installer 
does not automatically start, open the CD-ROM 
directory using Windows Explorer and double-click 
RM10setup.exe.

Note
• When the [User Account Control] dialog box appears, click 

[Yes] or [Continue].

• If .NET Framework 3.5 is not installed on your computer, a 
dialog box is displayed asking you to install .NET Framework 
3.5. Click [Install] to start installation of .NET Framework 3.5.

The .NET Framework is not automatically installed. 
Download the install file from the Microsoft download center 
and install it, or use the installer bundled on the set-up CD-
ROM (Applications folder > DotNetFramework folder > 
dotnetfx35.exe).

• Install RM-Lite v1.1 without uninstalling v1.0 when 
upgrading. If you uninstall v1.0 before installing v1.1, you will 
need to redo all of your camera and recording settings.

• Double-click RMLiteInstall.exe in the [Applications] folder 
on the setup CD-ROM bundled with the camera.

The Storage Server, Viewer, or both are installed, 
depending on the license key(s) you entered.

The license key input dialog box is not displayed. 
Instead, enter your name and affiliation in the dialog box 
that is displayed and click [Next].

Installation

Important
You must log on to the computer as a computer administrator to 
install this software.

1 Insert the installation CD-ROM into the CD drive.

2 Click [Next].

3 Read the license agreement carefully. Click [I accept 
the terms in the license agreement], if you accept 
them, and then click [Next] to continue.

4 Enter your license key(s) and click [Next].
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Note

• You can click [Change] to change the destination folder. 
However, we recommend that you do not change the 
destination.

• To check the available disk space on each drive of the 
computer and the disk space required for installation, click 
[Space].

• A dialog box asking you to specify the software to be 
installed is displayed. If you click [All], proceed to the step 6. If 
you click [Custom], the sample dialog box above is displayed. 
Select which application to install, the Storage Server or the 
Viewer. Click the application that you do not want to install and 
select [This feature will not be available].

Note

• When installing on a PC that has multiple network interfaces, 
select the network interface to use in the [Network adapter] list 
and the assigned IP address in the [IP address] list.

• If you clear the [Add storage server programs to the Windows 
Firewall exception list.] check box, you need to configure 
Windows Firewall after the installation is complete. For details, 
see “Windows Firewall Settings” (p. 34).

One of the following icon appears on your desktop when 
the installation is complete.

5 Click [Next].

6 Click [Next].

Important

If you change the network interface or IP address after this 
point, you will need to reinstall the software.

7 Click [Install].

8 Click [Finish].

9 Click [Yes] to restart the computer.

Important

• You must restart the computer to enable the settings that 
were made during the installation.

• You must configure the operating system after installation. 
For details, see “Settings After Installation” (p. 34).

• If you reinstall this software after uninstalling it, the setting 
configurations before uninstallation will not be retained. If you 
want to reinstall this software, we recommend that you 
backup the settings as a configuration file before 
uninstallation. For details on backup, see “Chapter 8 
Backup”.
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Configure the following settings after installing this 
software according to the operating system you are using:

( : Required, —: Not required)

Windows Firewall Settings

If you install the Storage Server and the Viewer on 
different computers, you must change the Windows 
Firewall settings on the computer used for the Storage 
Server.
The changes to the settings are already complete if you 
selected the [Add storage server programs to the 
Windows Firewall exception list.] check box during 
installation. If you did not select the above check box 
during installation, perform the following procedure to 
change the Windows Firewall settings.
The following settings are not required if you install the 
Storage Server and Viewer onto the same computer.

When using Windows 7 or Windows Server 
2008 R2

When using Windows Vista or Windows Server 
2008

If the [Control Panel] is set to [Classic View], double 
click [Windows Firewall].

If the [User Account Control] dialog box is displayed, 
click [Continue].

Settings After Installation

Windows 7, 
Windows Vista

Windows Server 
2008, Windows 
Server 2008 R2

Windows Firewall 
Setting

Security Level 
Setting

—

Sound Settings for 
Using the Audio 
Feature

—

Warning When 
Viewer Starts

1 Click [Start] > [Control Panel] to open the [Control 
Panel].

2 Click [System Security] > [Windows Firewall].

3 Click [Advanced Settings] to display the [Windows 
Firewall with Advanced Security] window.

4 Click [Inbound Rules] and select [New Rule] from the 
[Action] menu to start the [New Inbound Rule Wizard].

5 Click [Port], and then click [Next].

6 Click [TCP] and [Specific local ports], and then enter 
80 as the port number. Then click [Next].

7 Click [Allow the connection], and then click [Next].

8 Click [Next].

9 Enter a name (such as the Storage Server or Storage 
Server Group name) in [Name] and click [Finish].

10 The added inbound rule should be displayed in the 
[Windows Firewall with Advanced Security] window, 
with a checkmark icon displayed next to the rule.

1 Click [Start] > [Control Panel] to open the [Control 
Panel].

2 Click [System Security] > [Windows Firewall].

3 Click [Change settings].

4 Click the [Exceptions] tab and click [Add Port].

5 In the [Add a Port] dialog box, enter the name of the 
Storage Server and 80 as the port number. Make sure 
that [TCP] is selected and click [OK].

6 Confirm that the added Storage Server is now 
displayed in the [Windows Firewall] dialog box and that 
the check box is selected. Then, click [OK].
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In Internet Explorer, the default security level setting for 
Internet or intranet sites in Windows Server 2008 and 2008 
R2 is “High”. Therefore, you are not able to configure 
settings in the configuration or top page of the camera. 
Follow these steps to register the site as a trusted site.

Note
• For details on registration with trusted sites, click [Learn more 

about Internet Explorer’s Enhanced Security Configuration] in 
the [Internet Options] dialog box and refer to the displayed 
summary.

• JavaScript may be disabled in the standard security setting, 
even if a content block dialog box is not displayed. This may 
limit the operation of the setting page or the camera’s Viewer. 
The JavaScript setting is enabled automatically once trusted 
site registration is complete.

Sound Settings for Using the Audio Feature

The sound feature is disabled by default in Windows 
Server 2008 and 2008 R2. To receive audio with the 
camera’s Viewer, follow these steps to enable the sound 
feature.

If the [Control Panel] is set to [Classic View], double-
click [Sound] and proceed to Step 3.

If no audio device is installed, refer to the manual for 
your computer on how to install an audio device.

Warning When Viewer Starts

If [User Account Control] is enabled, the [User Account 
Control] screen will be displayed when you start the 
Viewer. Click [Yes] (or [Continue]) to start the Viewer.

1 Start Internet Explorer and click [Tools] > [Internet 
Options] to display the [Internet Options] dialog box.

2 Click the [Security] tab.

3 Click [Trusted Sites] and click [Sites].

4 Clear the [Require server verification (https:) for all 
sites in this zone] check box.

5 Enter the IP address of your camera in [Add this 
website to the zone] and click [Add].

1 Click [Start] > [Control Panel] to open the [Control 
Panel].

2 Click [Hardware and Sound] and click [Sound].

3 If the [Audio Service Not Running] dialog box is 
displayed, click [Yes].

4 The [Sound] dialog box is displayed. Select the 
[Playback] tab and confirm that an appropriate audio 
device is installed.
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Chapter 3
Storage Server Settings

❏ Adding cameras

❏ Configuring the Storage Server Group

❏ Adding users
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Flow of Storage Server Settings

Start the Viewer (p. 39)

Configure a Storage Server Group

Display the [Storage Server Group Settings] dialog box (p. 41)

Change the Storage Server Group name (p. 41)
Configure the recording settings (p. 41)

Configure the event priority and e-mail notifications (p. 42)

Configure a Storage Server

Display the [Servers] tab (p. 45)

Specify the storage period for recorded images (p. 45)
Change the destination of the recording file and the maximum disk usage (p. 46)

Add a camera

Display the [Cameras] tab (p. 47)

Add cameras one at a time (p. 47) Search for and add cameras (p. 48)

Add a user

Display the [Users] tab (p. 51)

Add a user (p. 52) Add a user group and specify its access permissions (p. 53)

Important

We strongly recommend that only one administrator configure the Storage Servers on each network.
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Double-click the [RM-Lite Viewer v1.1] icon on your 
desktop

Note

If the [User Account Control] dialog box appears, click [Yes] (or 
[Continue]).

➀ [Host Name]
Enter the host name or the IP address of the Storage 
Server Group. If the Viewer and the Storage Server are 
installed on the same computer, enter “localhost”.

➁ [Port]
Normally, leave [80] unchanged.

➂ [User Name], [Password]
Enter your user name and password.
The default user name and password are:
User Name: administrator
Password: NVR

➃ [Remember user name]
Select the check box if you want the software to 
remember the user name.

➄ [Use Group Name]
Click to specify a Storage Server Group name for the 
connection.

Note
• The first time you connect to the Storage Server Group, you 

must enter the host name and port number. However, from the 
second time onward, you can simply specify the Storage 
Server Group name (p. 40).

• If there are no cameras added, a message is displayed asking 
if you want to add a camera. Click [Yes] to display the [Add 
Camera] dialog box and start adding a camera on the network. 
For details, see “Add Cameras One at a Time” (p. 47).

• You can configure the Viewer to start without displaying the 
startup screen or the [Connect to Storage Server Group] dialog 
box. For details, see “Create a Shortcut Icon for Starting the 
Viewer” (p. 130).

Start the Viewer

Important

• The Viewer cannot be started on its own. Be sure to start the 
Viewer in an environment that allows it to connect to the 
Storage Server.

• You must log on as a computer administrator to configure the 
Storage Server from the Viewer.

• Check to make sure that other users are not connected to the 
Storage Server before configuring it from the Viewer.

1 Double-click the [RM Viewer v1.0] icon on your 
desktop.

2 Specify the information required to connect to the 
Storage Server Group.

3 Click [Connect].

➀

➂

➃

➄

➁

Important

• You should change the password for the default user 
(administrator) as a security measure. For details on how to 
change the password, see “Add a User” (p. 51).

• Be sure to remember your password.

• You must start the Viewer while logged on as a user in the 
Administrator user group to be able to set up the Storage 
Server.
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Specify the Storage Server Group for Starting 
the Viewer

You can start the Viewer using a Storage Server Group 
name instead of the host name of the server.

Double-click the [RM-Lite Viewer v1.1] icon on your 
desktop

Note

If the [User Account Control] dialog box appears, click [Yes] (or 
[Continue]).

➀ [Group Name]
Display the Storage Server Group name.

➁ [User Name] and [Password]
Enter the use name and password.
The default user name and password are:
User Name: administrator
Password: NVR

➂ [Remember user name]
Select the check box if you want the software to 
remember the user name.

➃ [Use Host Name]
Click to specify a host name of the Storage Server for 
the connection.

1 Double-click the [RM Viewer v1.0] icon on the desktop.

2 Click [Use Group Name].

3 Specify the information required to connect to the 
Storage Server.

4 Click [Connect].

➀

➁

➂

➃
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You can configure the recording method and event 
priority.

Display the [Storage Server Group Settings] 
Dialog Box

The [Storage Server Group Settings] dialog box is 
displayed.

➀ [Storage Server Group]
Display the Storage Server Group name.

➁ [Edit]
Change the name of Storage Server Group.

➂ [Recording Settings] tab
Make settings for recording files and notifications of 
available disk space.

[Maximum File Size/Duration] and [Reduce 
recording frame rate when disk is under high load] are 
fixed.

➃ [Events] tab
Configure the method for processing events for a 
Storage Server.

➄ [OK] and [Cancel]
Close the dialog box.

Change the Storage Server Group Name

Configure the Recording Settings

Configure the recording settings, such as the maximum 
recording file size.

➀ [Maximum File Size / Duration]
Specify the maximum size or the maximum recording 
duration for the recording file.
You can set a maximum file size of 512 MB or 1024 MB, 
and a maximum recording duration of 1 to 24 hours.

The maximum size is fixed at 1 GB (1024 MB) and 
the maximum duration is fixed at 24 hours.

➁ [Low Disk Space Warning Level]
Specify when to notify the user of low available disk 
space as a percentage of the maximum disk usage.

➂ [Reduce recording frame rate when disk is under high 
load]
Select the check box to decrease the frame rate 
automatically when the system load is high.

➃ [OK] and [Cancel]
Close the dialog box.

Configure a Storage Server Group

1 Click [Settings] > [Storage Server Group].

➀
➂

➁
➃

➄

1 Click [Edit] to display the [Edit Storage Server Group 
Name] dialog box.

2 Change the Storage Server name and click [OK].

1 Click the [Recording Settings] tab.

2 Configure the recording settings.

➁

➀

➂

➃
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Note
Select [Reduce recording frame rate when disk is under high 
load] to trigger an event and send an e-mail notification when the 
recording frame rate decreases.

[Reduce recording frame rate when disk is under 
high load] is always enabled. You cannot disable it. You 
can confirm whether the frame rate has been 
automatically reduced by checking the [Live Events Log]. 
(An e-mail notification is not sent.)

Configure Event Priorities and E-mail 
Notifications

Configure the priority of an event that occurs in the 
Storage Server Group.

➀ [E-mail Notification]
Display a list of e-mail addresses for sending 
notification messages when an event is triggered, and 
the priority of the event.

➁ [Add], [Edit], and [Remove]
Add, edit or remove an e-mail notification destination.

➂ [Mail Server Settings]
Configure the mail server used for notifications.

➃ [Event Priorities]
Configure the event priorities.

➄ [OK] and [Cancel]
Close the dialog box.

3 Click [OK] to close the dialog box.

Important

An event is triggered and a notification e-mail is sent when the 
available disk space reaches the value specified in [Low Disk 
Space Warning Level]. 1 Select the [Events] tab.

➀

➁ ➂

➃

➄
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Configure the Mail Server

➀ [SMTP Server] and [Port]
Enter an SMTP server name and change the port 
number, as required.

➁ [Authentication]
Specify an SMTP server authentication method 
([None], [POP before SMTP], [SMTP-AUTH]).

➂ [User Name]
If [POP before SMTP] or [SMTP-AUTH] is selected in 
[Authentication], enter a user name to be used for 
authentication.

➃ [Password]
Enter a password to be used for authentication with the 
user name entered in ➂.

➄ [POP Server] and [Port]
If [POP before SMTP] is selected in [Authentication], 
enter the name of the POP server to be used for 
authentication and the port number, as required.

➅ [OK] and [Cancel]
Close the dialog box.

Note

If [POP before SMTP] is selected in [Authentication], the Storage 
Server performs POP authentication before sending an e-mail 
message.

Add an E-mail Notification Destination

➀ [To]
Enter an e-mail address as the destination.

➁ [From]
Enter the e-mail address of the sender.

➂ [Subject]
Enter the subject of the e-mail.

➃ [Min. Priority]
Specify the minimum event priority level which will 
generate an e-mail notification.

➄ [OK] and [Cancel]
Close the dialog box.

The e-mail address for the specified destination and 
the event priority are added to the [E-mail Notification] 
list.

1 Click [Mail Server Settings] to display the [Mail Server 
Settings] dialog box.

2 Configure the mail server settings.

3 Click [OK] to close the dialog box.

➀
➁

➄

➅

➂

➃

1 Click [Add] in the [Events] tab of the [Storage Server 
Group Settings] dialog box to display the [E-mail 
Notification Settings] dialog box.

2 Configure the e-mail notification settings.

3 Click [OK] to close the dialog box.

➀

➁

➃

➄

➂



44

Specify the Event Priority

Change the priority depending on the event type using 
[Event Priorities] in the [Events] tab. E-mail notification is 
performed according to the specified priorities.

Click or drag the slider for each event to change the 
priority.
The priority can be set to one of the following five levels:

Level Value Color

Highest Red

High Orange

Medium Yellow

Low Light Green

Lowest Green
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You can specify the storage period of the recorded 
images and the maximum disk usage.

Display the [Servers] Tab

The [Servers] tab is displayed in the [Settings] dialog 
box.

➀ [Storage Server Group]
Display the Storage Server Group name.

➁ List of Storage Servers
Display a list of Storage Servers.

➂ [Edit]
Edit a Storage Server.

➃ [Recorded Video Settings]
Specify the minimum and maximum storage period for 
recorded images.

➄ [Close]
Close the dialog box.

Specify the Storage Period for Recorded 
Images

You can specify the storage period for images recorded 
on the Storage Server.
• To specify the minimum storage period, select the 

[Ensure video is kept for at least] check box. Select the 
units (day or week) of the storage period and enter the 
number of days or weeks, up to a maximum of 99.

• To specify the maximum storage period, select the 
[Ensure video is kept for upto] check box. Select the 
units (day or week) of the storage period and enter the 
number of days or weeks, up to a maximum of 99.

• Select the units (days or weeks) of the storage 
period and enter the number of days (1 to 90) or weeks 
(1 to 12). [Ensure video is kept for upto] is always 
enabled.

Configure a Storage Server

1 Click [Settings] > [Storage Servers].

➄

➀

➁

➃

➂

Important
Depending on the maximum disk usage setting for the Storage 
Server (p. 46), recordings may not be stored for the full storage 
period specified in this setting.
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Change the Destination of the Recording File 
and the Maximum Disk Usage

Specify a drive for recording or change the maximum disk 
usage.

Click [Do not limit] for each drive to display the 
maximum disk usage. Select the [Maximum Disk 
Space Used] check box and specify a maximum disk 
usage that does not exceed the total disk capacity.

1 Select a Storage Server from the list of Storage 
Servers.

2 Click [Edit] to display the [Storage Server Settings] 
dialog box.

3 Clear the check boxes next to the drives that are not 
used for recording.

4 Specify the maximum disk usage.

5 Click [OK] to close the dialog box.

Important
• We recommend that you do not specify the system drive 

(typically the C drive) as the destination for the recording file.

• You cannot specify a drive that has a capacity of less than 
1 GB.
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You can add a camera to be used for displaying images 
or recording to a Storage Server.

Note
• The number of cameras you can add to a Storage Server 

depends on the version of this software product.

• You can add up to four cameras.

Display the [Cameras] Tab

Display the [Cameras] tab in the [Settings] dialog box to 
start adding a camera.

➀ [Storage Server Group]
Display the Storage Server Group name.

➁ List of cameras
Displays a list of already added cameras.

➂ [Find]
Search for cameras on the network.

➃ [Add], [Edit], and [Remove]
Add, edit or remove a camera.

➄ [Close]
Closes the dialog box.

Add Cameras One at a Time

Add cameras one at a time to the list of cameras on the 
[Cameras] tab.

➀ [Host Name]
Enter the host name or IP address of the camera.

➁ [Port]
Enter the port number for communicating with the 
camera. Typically, leave [80] unchanged.

➂ [User Name]
Enter the user name for the camera.

➃ [Password]
Enter the password for the user specified in ➂.

➄ [Storage Server Group]
Display the Storage Server Group name.

➅ [Tags]
Display the tags assigned to the camera.

➆ [Edit]
Specify a new tag and add it to the list in ➅.

➇ [Remove]
Remove tags selected in ➅.

➈ [OK] and [Cancel]
Close the dialog box.

Add a Camera

1 Click [Settings] > [Cameras].

➀

➁

➃➂ ➄

1 Click [Add] to display the [Add Camera] dialog box.

2 Enter the information required to add the camera.

➀

➆

➈

➂

➃

➄
➅

➁

➇
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The camera is added in the list of cameras on the 
[Cameras] tab.

Images from a video camera connected to a multi-
terminal VB-EX50 cannot be displayed or recorded by this 
software.

Assign Camera Tags

You can assign keywords, such as the installation 
location, called camera tags, to the camera.
Click [Edit] in the [Add Camera] dialog box when you are 
adding the camera to display the [Edit Tags] dialog box.

➀ List of camera tags
Displays a list of assigned camera tags. Select the 
check box of the tag to assign it to the camera. You 
can assign more than one camera tag.

➁ Add camera tag area
Add a new camera tag.

[Add]
Enter a tag name in the text box and click this button to 
add the tag to the list.

➂ [OK] and [Cancel]
Close the dialog box.

Using Camera Tags

Camera tags help you organize cameras more easily.

Selectively Displaying Cameras
You can use camera tags to selectively display cameras 
in the following windows and dialog boxes:
• Camera Selector (p. 59)
• [Recording Schedule] window (p. 73)
• [System Information] window (p. 109)

Specifying a Camera
You can specify a camera using camera tags when doing 
the following operations:
• Specifying a camera with access permissions for user 

group operation (p. 53)
• Specifying a camera to be automatically displayed in 

the dynamic layout (p. 67)

Search For and Add Cameras

You can search for cameras that are on the same network 
as the Storage Server.

The cameras on the subnet are displayed in the 
[Camera Search Results] dialog box.

You can add more than one camera by selecting 
multiple check boxes.

The [Add Camera] dialog boxes for the cameras 
selected in step 2 are displayed in the order of the 
[Camera Search Results] list (from top to bottom).

3 Click [OK] to close the dialog box.

Important

• Enter the camera’s user name and password in [User Name] 
and [Password].

• If the host name or IP address of the camera is changed after 
registration, you must also change the Storage Server 
setting. For details, see “Edit Camera Information” (p. 49).

➀

➁

➂

1 Click [Find].

2 Select the check box of a camera you want to add. To 
select all the cameras, click [Select All].

3 Click [Add].

4 Enter the information required to add the camera, 
referring to step 2 in “Add Cameras One at a Time” 
(p. 47).

5 Click [OK] to close the dialog box.
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Note
• You can only search for cameras on the same subnet as the 

Storage Server. For details on how to add cameras on a 
different subnet, see “Add Cameras One at a Time” (p. 47).

• The names of the cameras (stored on the camera) are 
displayed in the list in the [Camera Search Results] dialog box. 
However, the VB-C300 camera name is not displayed.

• Cameras that have already been added are also found. 
However, a check box is not displayed next to the camera.

• If you cannot find the camera you are searching for, see “Add 
Cameras One at a Time” (p. 47) and add the camera.

• Host names or IPv4 addresses are displayed in the [Host 
Name] column of the [Camera Search Results] dialog box. 
(IPv6 addresses are not supported.)

Edit Camera Information

You can edit the camera registration information, such as 
the camera name or the thumbnail image displayed in the 
Viewer.

[General] tab

➀ Camera name box
Enter a camera name.

➁ [Update]
Update the thumbnail image in the camera selection 
panel.

➂ [Tags]
Displays the tags assigned to the camera.

➃ [Edit]
Add a new tag to the list in ➂.

➄ [Remove]
Remove tags selected in ➃.

➅ [OK] and [Cancel]
Close the dialog box.

➆ [Apply]
Apply the settings in the dialog box.

Note
The camera name specified in the text box is only used by this 
software product. The camera name stored on the camera is not 
changed.

[Advanced] tab

➀ [Host Name]
Change the host name or IP address of the camera.

➁ [Port]
Change the port number used for communicating with 
the camera. Typically, leave [80] unchanged.

➂ [User Name]
Change the user name of the camera.

➃ [Password]
Change the password for the user entered in ➂.

➄ [Disable Camera]
Disables the camera temporarily. To enable the 
camera, click [Enable Camera].

➅ [Storage Server Group]
Display the Storage Server Group name.

➆ [OK] and [Cancel]
Close the dialog box.

➇ [Apply]
Apply the settings in the dialog box.

6 Repeat steps 4 and 5.

7 When you finish adding cameras click [Cancel].

1 Select a camera in the list and click [Edit] in the 
[Settings] dialog box to display the [Camera 
Properties] dialog box.

2 Configure the displayed settings.

➁

➂

➃ ➄

➀

➅ ➆

➀

➂

➃

➅

➄

➁

➆ ➇
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Note
• Items ➀ to ➃ can only be changed if the camera is disabled 

using [Disable Camera].

• If a camera is not working, you can disable it to prevent 
communication error notifications from being sent repeatedly.

• If you replace a camera that is not working with another 
camera, the host name, etc, is changed to that of the new 
camera, so there will be no effect on existing recording 
schedules and settings. (The replacement should be the same 
model as the original camera.)

Change the Thumbnail Image of a Camera

You can change the thumbnail image of a camera.
In the [Camera Properties] dialog box, click the [General] 
tab and click [Update] to display the [Thumbnail] dialog 
box.

➀ Preview video
Drag the slider to change the zoom position of the 
camera. Click in the preview video to change the 
camera position. 

➁ [Select Preset]
Select a preset made with the camera.

➂ [Update]
Use the current preview video as the camera thumbnail 
image. The [Thumbnail] dialog box closes and the 
camera thumbnail image is updated.

➃ [Cancel]
Close the dialog box without updating the thumbnail 
image.

You cannot use the pan/tilt/zoom feature.

You cannot use the pan/tilt feature.

You cannot use the zoom feature when the digital zoom is 
set to [Disabled] on the camera.

Note
You must configure the presets first before starting operation. For 
details, see the camera manual.

Remove a Camera

➀

➁

➂

➃

1 Select a camera in the list of cameras on the 
[Cameras] tab.

2 Click [Remove].

3 A message is displayed asking if you want to remove 
the camera. Click [Yes].

Important

If you remove a camera, you will no longer be able to play back 
recordings made with the camera. If you need to play back the 
recordings, use [Disable Camera] on the [Advanced] tab 
instead of removing the camera.
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You can add users to the Viewer and place them in the 
administrator group or the general user group.

About User Groups

The Viewer provides the following two user groups, each 
with different user permissions.

• Administrator
Users in this group can fully operate the Viewer.

• Operator
Users in this group have limited access to the features 
of the Viewer. They cannot configure a camera or set a 
recording schedule.

You can specify the group to which the added user 
belongs by selecting from [User Group].
You can create a new user group and specify permissions 
for users that belong to the group.

Note
Administrator for this software program does not refer to the 
Windows administrator.

Display the [Users] Tab

The [Users] tab is displayed in the [Settings] dialog 
box.

➀ [Storage Server Group]
Display the Storage Server Group name.

➁ List of users
Displays a list of existing users.

➂ [Add], [Edit], and [Remove]
Add, edit or remove a user.

➃ [User Group Settings]
Add, edit or delete a user group.

➄ [Close]
Closes the dialog box.

Add a User

Important
• A default user called “administrator” is created in the 

Administrator user group. The password for this user is 
“NVR”. We recommend that you change the password for 
this user after installation. We strongly recommend that, for 
normal surveillance operation, you create individual users 
with access permissions for only the minimum required 
functionality.

• Be sure to remember your password.

• You cannot add user groups.

1 Click [Settings] > [Users].

➀

➃

➄

➁

➂
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Add a User

Use this tab to add a new Viewer user. Also use it to 
specify the kind of user (Administrator or Operator).

➀ [User Name]
Enter the name of the user to be added.

➁ [Password]
Enter the password used to log into the Viewer.

➂ [Confirm Password]
Enter the password again for confirmation.

➃ [User Group]
Select the user group (“Administrator” or “Operator”).
You can also select an added user group. For details, 
see “Add a User Group and Specify Its Access 
Permissions” (p. 53).

➄ [OK] and [Cancel]
Close the dialog box.

The added user appears in the list of users on the 
[Users] tab.

Change the User Information

➀ [User Name]
All user names can be changed, except for the default 
“administrator” user name.

➁ [Old Password]
Enter the old password.

➂ [New Password]
Enter the new password.

➃ [Confirm New Password]
Enter the new password again for confirmation.

➄ [User Group]
Select a user group (“Administrator” or “Operator”).
You can also select an added user group (p. 53).
The default “administrator” user is associated with the 
Administrator user group. You cannot change this user 
group for the default “administrator” user.

➅ [OK] and [Cancel]
Close the dialog box.

1 Click [Add] to display the [Add User] dialog box.

2 Enter the information required to add the user.

3 Click [OK] to close the dialog box.

➀

➁

➂

➃

➄

1 Select a user in the list.

2 Click [Edit] to display the [Edit User] dialog box.

3 Change the user information.

4 Click [OK] to close the dialog box.

➀

➁

➂

➃

➄

➅
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Remove a User

Note

You cannot delete the default “administrator” user.

Add a User Group and Specify Its Access 
Permissions

You can create additional user groups and specify 
access permissions for the group.
In the [Settings] dialog box, click the [User] tab and click 
[User Group Settings] to display the [User Group 
Settings] dialog box.

➀ List of user groups
Displays a list of existing user groups.

➁ [Add], [Edit], and [Remove]
Add, edit or remove a user group.

➂ [Full Control]
Assign all access permissions for the selected user 
group.

➃ [Partial Control]
Specify individual access permissions for the selected 
user group.

➄ [Close]
Close the dialog box.

Note
You cannot edit or remove the “Administrator” and “Operator” 
user groups.

Specify Individual Access Permissions

Click [Partial Control] and select the check boxes next to 
the desired access permissions for each feature.

Select the check box next to a feature to enable operation 
of the feature.
Camera tags are only displayed for [View Live Video], 
[Playback Recorded Video], and [View Recording 
Schedules]. Click a tag to display a dialog box for 
specifying camera tags to narrow down the cameras to 
which the access permissions will be assigned.

1 Select a user in the list.

2 Click [Remove].

3 A message asking if you want to remove the user is 
displayed. Click [Yes].

➄

➃

➁

➂

➀

Access permissions for 
each feature

Selected camera tags
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Chapter 4
Viewer Settings

❏ Configuring the Viewer

❏ Configuring a camera

❏ Creating a layout
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Flow for Viewer Settings

Start the Viewer (p. 39)

Configure the Viewer

Display the [Viewer Settings] dialog box (p. 57)

Configure the Viewer display and operation settings (p. 57) Configure the display/hide mode for each event (p. 58)

Configure event notification and priorities (p. 58)

Configure the camera

Display the [Camera Selector] dialog box (p. 59)

Select a camera (p. 59) Configure the [Advanced Camera Settings] (p. 61)

Configure the video window (p. 60)

Configure the video window layout 

Create a layout (p. 65)

Place a video window (p. 66)

Save the layout (p. 67)

Configure a dynamic layout (p. 67)

Configure a layout sequence (p. 68)

Important

We strongly recommend that only one administrator configure the Storage Servers on each network.



57

V
iew

er S
ettings

4
Start the Viewer and configure it for day-to-day 
operations. For details on how to start the Viewer, see 
“Start the Viewer” (p. 39).

Display the [Viewer Settings] dialog box

The [Viewer Settings] dialog box is displayed.

➀ [General] tab
Configure the Viewer screen display settings.

➁ [Event Notification] tab
Configure how the Viewer displays an event.

➂ [Event Display] tab
Specify the types of events to be displayed in the 
Viewer.

➃ [OK] and [Cancel]
Close the dialog box.

Configure the Viewer Display and Operation 
Settings

➀ [Maximum Live Frame Rate]
Specify the maximum live view frame rate.

➁ [Manual Recording Duration]
Specify the [Record Now] recording time, from 30 to 
300 seconds.

➂ [Auto adjust frame rate under heavy load]
Automatically adjust the display frame rate.

➃ [Use large captions for video window title bars]
Increase the title bar text size of the video window.

➄ [Confirm when changing to full screen mode]
Display a confirmation message when switching to full 
screen mode.

➅ [Prompt to save changes when layouts are closed]
Display a confirmation message when a layout in the 
Viewer is closed. The message is not displayed if the 
layout is not changed.

➆ [Timeout Before Ending]
Automatically stop two-way audio communication after 
the specified period, from 1 to 60 minutes.
You can also specify 0 minutes. However, two-way 
audio communication will not stop automatically in 
such cases, so you must stop it manually. We 
recommend setting an arbitrary timeout duration to 
avoid unintentional continuation of audio 
communication.

Configure the Viewer

1 Click [Settings] > [Viewer].

➀ ➁ ➂

➃

1 Click the [General] tab.

2 Configure each item.

➀

➁

➂
➃
➄

➅

➆
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Configure Event Notification and Priorities

➀ [Show Events in Live Events Log and Timeline]
Display an event in the [Live Events Log] dialog box 
and on the timeline.

[Equal to or higher than]
Specify the priority of events to be displayed.

➁ [Show Video Window on Event]
Automatically display the camera’s video window when 
an event occurs.

[Equal to or higher than]
Specify the priority of events for which a video window 
is displayed.

➂ [Operator Notification]
Notify the operator that an event occurred.

[Equal to or higher than]
Specify the priority of events to be notified.

[Flash event indicator for]
Specify the time the event indicator flashes right after 
the event occurs, from 1 to 99 seconds.

[Play audio alert]
Beep when an event occurs.

[Display event indicator during playback]
Display an event during playback.

➃ [Acknowledge Event]
Prompt the operator to acknowledge an event.

[Equal to or higher than]
Specify the priority of events to be acknowledged.

You cannot change the [Show Video Window on 
Event], [Operator Notification], and [Acknowledge Event] 
settings.

Configure the Display/Hide Mode for Each 
Event

Specify the types of events displayed in the [Live Events 
Log] dialog box and on the timeline.

Select an event to be displayed in the [Live Events 
Log] dialog box and on the timeline.

1 Click the [Event Notification] tab.

2 Configure each item.

➀

➁

➂

➃

1 Click the [Event Display] tab.

2 Specify whether or not to display each type of event.
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Display the [Camera Selector] dialog box

The [Camera Selector] dialog box is displayed.

➀ [Search for] box
Search for the camera to be used for display.

➁ Camera list
Displays a list of registered cameras.

Note

Each time you select [Window] > [Camera Selector], the display 
of the [Camera Selector] dialog box is toggled on or off.

Select a Camera

When you have a large number of cameras registered, 
search for the camera using the camera name or any 
associated tags.

The following items are displayed when you click the 
search button.

• [Name, Tag or Status]
Enter a camera name, tag or camera status in the 
search criteria box.

• [Camera Name]
Enter the camera name in the search criteria box.

• [Tag]
Select the camera tag to be searched.

• [Camera Status]
Select the camera status to be searched.

• [Camera Type]
Select the model name to be searched.

• [Host Name (camera)]
Enter the camera host name or IP address in the 
search criteria box.

• [Storage Server Group Name]
Searching by this item is not available.

Configure the Camera

1 Click [Window] > [Camera Selector].

➀

➁

1 Click the search button and specify the search criteria.

2 Specify the search criteria and search for the camera.

3 Double-click the camera in the search results to 
display the video window.

Search button

Search criteria box
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➀ Video window menu button
Click to display a menu for operating the video window.

➁ Title bar
Displays the camera name and type of image being 
displayed.

With the on-screen display feature enabled, if you set the 
display position to the lower right or lower left, the video 
window title bar, the recorded image indicator, or the 
event indicator may hide the text that should be 
displayed.

Configure the Video Window

You can configure the video window settings, including 
the window size and the video format (JPEG or MPEG-4).

Change the Video Window Size

• [160x120] / [320x240] / [640x480]
Change the size of the video window, selecting from 
small ([160x120]), medium ([320x240]) and large 
([640x480]).

• [Default]
Adjusts the size of the video window to the received 
image size. For the image size during reception, see 
“Change the Video Window Resolution” (p. 61).

• [Full Screen]
Display an image on the entire screen. For details, see 
“Display the video Full Screen” (p. 61).

Note
• Drag the lower right corner of the video window to resize it.

• If the video window size selected in the [Video Receive Size] 
submenu is greater than [640 x 480], the load on the CPU will 
increase and the Viewer may operate more slowly.

4 To display images from other cameras, repeat step 3.

Important

• When an error occurs, the corresponding error message is 
displayed in the video window. For details, see “Error 
Messages in the Video Window” (p. 121).

• The number of video windows that can be displayed in the 
Viewer depends on factors such as the graphics card, CPU 
performance, frame rate, camera image size, and the image 
quality.

• Viewer operation may slow down under high CPU loads.

➀ ➁ 1 Click the video window menu button to display the 
menu.

2 Click [Video Display Size] and select the video window 
size from the submenu.
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Change the Video Window Format

• [MPEG-4] is unavailable.
• The live video and its audio are not in synch when 

[H.264] is selected.

• [H.264] is unavailable.
• The live video and its audio are not in synch when 

[MPEG-4] is selected.

[MPEG-4] and [H.264] are unavailable.

Change the Video Window Resolution

Select [Default] to use the camera’s resolution.

[1280 x 960] is unavailable.

The resolution cannot be specified for [H.264] format.

The resolution cannot be specified for [MPEG-4] format.

Note
• If you save the layout (p. 67), the [Video Receive Size] setting 

is also saved.

• The size used for [Default] is determined the first time you 
display a video from the camera. The size on the Viewer will 
not change, even if you change the size setting on the camera.

Display the video Full Screen

You can display the video full screen.

A white frame is displayed surrounding the selected 
video window.

The video from the selected video window is 
displayed full screen.

Configure the [Advanced Camera Settings]

1 Click the video window menu button to display the 
menu.

2 Click [Video Format] and select the video format 
([JPEG] or [MPEG-4], or [H.264]) from the submenu.

1 Click the video window menu button to display the 
menu.

2 Click [Video Receive Size] and select the resolution 
([160x120], [320x240], [640x480], [1280x960], or 
[Default]) from the submenu.

Important

When you display more than one video window for the same 
camera, changes to the resolution of one of these windows are 
applied to all of the other windows.

1 Click the video window menu button to display the 
menu.

2 Click [Video Display Size] and select [Full Screen] from 
the submenu.

3 A confirmation message is displayed. Click [Yes].

4 To exit full screen display, press the Esc key.

1 Click [Window] > [Camera Control].

2 Click the video window of the camera you want to 
configure and click [Control] on the [Camera Control] 
dialog box to get control of the camera.

3 Click [Advanced] on the [Camera Control] dialog box to 
display the [Advanced Camera Settings] dialog box.

4 Click the tab that you want to configure.

5 After configuring the settings, click [Close].

Important

If camera control is lost while the [Advanced Camera Settings] 
dialog box is open, you cannot continue configuring the 
settings. Click [Control] on the [Camera Control] dialog box 
again to get control and continue configuring the settings.
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Adjust the Image Quality

Adjust the image quality using the [Image Adjustment] tab 
in the [Advanced Camera Settings] dialog box.

[Image Adjustment] tab

➀ [Exposure]
The settings change according to the selected 
exposure setting.

• [Auto]
Automatically control the exposure.

• [Auto (Shutter Priority)]
Specify the shutter speed.

• [Auto (Flickerless)]
Reduce flicker from light sources, such as 
fluorescent lighting. The shutter speed is 
automatically adjusted according to the lighting 
conditions.

The following exposure compensation setting is 
displayed when [Auto], [Auto (Shutter Priority)] or [Auto 
(Flickerless)] is selected.

[Compensation]: Specify exposure compensation using 
seven levels, from -3 to +3 (alternately [Off], 
[Low], [Medium], [High]). Select negative 
values to darken the image and positive values 
to lighten the image.

[Metering Mode]: Specify the metering mode setting: 
[Center-weighted], [Average], or [Spot].

[Shutter]: Specify the shutter speed when [Exposure] is 
set to [Auto (Shutter Priority)] using 12 levels, 
from 1/8 to 1/8000 seconds.

Important

The settings may be different for different camera models. For 
details, see the camera manual.

➀

➁

➂

➃

Metering mode Description

[Center-weighted] Meters the entire scene, with an 
emphasis on the center. Correct 
exposure is obtained for a subject 
near the center of the scene, even 
though the periphery may be slightly 
darker or lighter. Use for subjects that 
are in the center of the scene.

[Average] Meters an average of the entire scene.    
A uniform exposure is obtained even 
when the scene has significant 
differences in brightness.
Use for scenes where, for example, 
cars are passing through or people 
are entering and exiting.

[Spot] Meters the center of the scene.
The correct exposure is obtained for a 
subject near the center of the scene, 
irrespective of the brightness of the 
periphery.
Use if the subject is lit by a spotlight or 
is backlit, where the exposure should 
be adjusted to the center of the 
scene.
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• [Manual]
Compensate for the exposure manually. The 
following exposure compensation settings are 
displayed.

[Iris]: Specify the iris setting. Drag the slider to the left 
to close down the iris and make the image 
darker or to the right to open up the iris and 
make the image brighter.

[Shutter]: Specify the shutter speed using 15 levels, 
from 1/1 to 1/8000 seconds.

[Gain]: Specify the gain (sensitivity to brightness). Drag 
the slider to the left to decrease the gain and 
make the image darker or to the right to 
increase the gain and make the image brighter.

➁ [Smart Shade Control]
Specify a value to use for the camera’s smart shade 
control feature for live image. Select one of seven 
levels, from 1 (weakest) to 7 (strongest), or [Off]. If [Off] 
is selected, the camera’s smart shade control setting is 
used for live image.

➂ [Aperture Mode]
Specify the camera aperture mode.

[Night Mode]

• [Disabled]
Disable the night mode function.

• [Enabled]
Display live image in night mode.

• [Auto]
The camera automatically switches to night mode.

➃ [White Balance]
Specify the appropriate white balance by selecting one 
of the camera’s light source settings displayed in the 
list.
If [Manual] is selected, use one of the following two 
methods to adjust the white balance.

• [R Gain] and [B Gain]
Specify the white balance parameters by dragging 
the sliders. Drag to the right to increase the gain (the 
sensitivity to brightness).

• [One Shot WB]
Force white balance adjustment to a light source. 
Using a white object (such as piece of white paper) 
as a standard, fill the shot with the object and click 
this button.

• You cannot specify [Aperture Mode] when you select 
[Auto] for [Aperture Mode] in a recording schedule.

• [Compensation] can be specified using seven levels, 
from -3 to +3. To disable exposure compensation, 
specify [0].

• [Compensation] can be specified as [Off], [Low], 
[Medium] or [High].

• The Smart Shade Control feature is not supported.
• You cannot select the [Metering Mode].

You cannot specify [Aperture Mode] when you select 
[Auto] for [Day/Night] in Video and Camera settings.

• [Auto] is unavailable for [Aperture Mode].
• [Exposure] and [White Balance] are unavailable.

Note
When [Night Mode] is enabled in [Aperture Mode], both the 
displayed and recorded images are in black and white.

Important

If you select [Enabled] for Night Mode, you will not be able to 
set the white balance. If you select [Auto] for Night Mode, 
however, you will be able to set the white balance, but those 
settings will be cleared when the camera switches to Night 
Mode.
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Adjust the Focus and Speed

You can use the [Focus and Speed] tab in the [Advanced 
Camera Settings] dialog box to adjust the focus and the 
pan/tilt/zoom speeds.

[Focus and Speed] tab

➀ [Auto], [Auto (for domes)]
Automatically focus the image.
Use [Auto (for domes)] for cameras equipped with an 
indoor dome housing. The setting prevents the camera 
from focusing onto the dome surface.

➁ [Fixed at infinity]
Fix the focal point at infinity.

➂ [Manual]
Adjust the focus manually by clicking the [Far] or 
[Near] button.
Click [One Shot AF] to focus once on the current 
subject and then return to manual focus.

➃ [Pan/Tilt]
Specify the pan/tilt speed ([Slow], [Normal] or [Fast]).

➄ [Zoom]
Specify the zoom speed ([Slow] or [Fast]).

The pan/tilt speed is unavailable.

When the digital zoom on the camera is set to [Disable], 
the zoom speed is unavailable.

Configure External Outputs

Use the [External Outputs] tab on the [Advanced Camera 
Settings] dialog box to configure output to external 
devices connected to the camera.

➀ [Off]
Disable the external output.

➁ [On]
Enable the external output.

Important

The settings may be different for different camera models. For 
details, see the camera manual.

➀

➂

➁

➃

➄

➀ ➁
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You can save the size and position of a video window in 
the Viewer as a layout.
Configure a layout using the following procedure:

The following special layouts are also provided:

• Dynamic layouts
Specify criteria, such as camera tags and events, to 
only display video windows that meet the criteria. You 
can also select a pre-defined dynamic layout.

• Layout Sequences
Sequence through multiple layouts you have created at 
a certain time interval.

Note
When the Viewer starts, it displays the layout that was being 
displayed when the program last ended. A new layout with the 
name “Untitled1” is opened the first time the Viewer is started. 
You can save the layout with a name after you place a video 
window.

Create a Layout

Specify the layout name, layout background and the video 
window display conditions and open it as a new layout.

➀ [Layout Name]
Enter the name of the layout.

➁ [Background]
Specify the background of the layout. Click [Browse] to 
specify an image (a .bmp file or JPEG file) to be used 
for the background.

➂ [Playback Options]
Specify how the video windows are displayed when the 
layout is opened.

• [View Live Video]
Display the live view from the camera.

• [Remember playhead positions]
Play back recordings starting from the positions that 
were playing when the program last ended.

• [Start at specific time]
Play back a recording starting at a specific time.

• [Start at offset before live]
Start playback from a position a specific amount of 
time in the past.

➃ [OK] and [Cancel]
Close the dialog box.

Configure the Video Window Layout

1. Create a layout

2. Place a video window 

3. Save the layout

1 Click [Layouts] > [New Layout] to display the [New 
Layout] dialog box.

2 Configure each item.

➁

➀

➂

➃
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Place a Video Window

You can place a video window anywhere in the viewing 
area.
You can arrange video windows according to a grid.

Change the Layout Background Image

You can select an image for the layout background.

Note

• The image that you specify as the background will be 
registered to the [Background] list in the layout properties.

• To disable backgrounds, select [(None)] in the [Background] 
list of the layout properties.

Display a Grid

• [None]
Do not display a grid.

• [Alignment]
Display a dotted grid.

• [160x120] / [320x240] / [640x480]
Display a solid grid with one of three sizes.

• [Custom]
Displays the [Custom Grid] dialog box.

Configure a Custom Grid
Selecting [Custom] as a grid type displays the [Custom 
Grid] dialog box, where you can configure the size of the 
grid.

➀ [Aspect Ratio]
Specify the aspect ratio of the grid frame ([4:3] or 
[16:9]).

➁ [Horizontal] and [Vertical]
Specify the number of horizontal and vertical pixels in 
the grid frame.
Changing the value for one of the items changes the 
value in the other box to maintain a constant aspect 
ratio.

➂ [OK] and [Cancel]
Close the dialog box.

Note

Using a custom grid may increase the load on the CPU.

Move a Video Window

You can drag a video window to any position.
When the grid is set to [None], the video window remains 
in the position to which it is dragged.
For options other than [None], the video window snaps to 
the grid position that is nearest to where the window is 
dragged.

Note
You can enlarge the video window in multiples of the grid frame 
size (2 x 2, 3 x 3, etc.).

3 Click [OK] to close the dialog box.

Important

Following the above steps does not automatically save the 
layout. Be sure to enter a name and save the new layout after 
configuring it.

1 Click [Layouts] > [Organize Layouts] to display the 
[Organize Layouts and Layout Sequences] dialog box.

2 Click the layout for which you want to specify a 
background, and click [Properties] to display the 
properties of the layout.

3 Click [Browse] for [Background].

4 Specify the image file to use as the background, and 
click [Open].

1 Click [Grids] on the toolbar.

2 Select the type of grid.

Important
The number of video windows that can be displayed in the 
Viewer depends on factors such as the video card, CPU 
performance, video frame rate, camera video size, and the 
video quality.

➁

➀

➂
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Save the Layout

After configuring the display and position of the video 
windows, follow these steps to save the layout.

Configure a Dynamic Layout

➀ [Layout Name]
Enter the name of the dynamic layout.

➁ [Display cameras that]
Specify the display criteria for cameras.
Click a check box to make a set of display criteria 
available, and then click each criteria list to select the 
criteria.
You can specify up to five sets of criteria.
The criteria are (from left to right), the property, 
operator, and status.

Select [All of the following are met] to display only 
cameras that meet all the criteria. Select [Any of the 
following are met] to display cameras that meet any of 
the criteria.

➂ [When conditions are not met, continue displaying 
cameras for]
Specify how long a video window in the layout will 
remain displayed when it does not match the criteria 
specified here.

➃ [OK] and [Cancel]
Close the dialog box.

1 Click [File] > [Save Layout].

2 Change the layout name as required, and click [OK].

1 Click [Layouts] > [New Dynamic Layout] to display the 
[New Dynamic Layout] dialog box.

2 Specify the criteria for the video windows displayed in 
the dynamic layout.

➁

➂

➀

➃

Property
Operator for the 

decision
Status

Tags  is
 isn’t

Camera tags

Status  is
 isn’t

Camera status 
(such as 
[Recording], 
[Idle], or [Error])

Event Type  is
 isn’t

Event type (such 
as [Motion] or 
[Sensor])

Event Priority is
is equal or higher than
is equal or lower than

Event priority 
([Highest], [High], 
[Medium], [Low], 
or [Lowest])

Storage 
Server Group

 is
 isn’t

The name of 
Storage Server 
Group to which 
the Viewer is 
connected.

3 Click [OK] to close the dialog box.

4 Click [File] > [Save Layout].

5 Change the layout name as required and click [OK].

Property
Operator

Status
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Switch Between Layouts

The menu is separated into two sub-menus:

• Shared layouts
Displays shared layouts under the name of the Storage 
Server Group. The [Layouts] menu shows the Storage 
Server Groups.
All users have access to the layouts, however, only the 
administrator can make changes to them.

• User layouts
Displays layouts created by the currently logged in 
user. These layouts are not available to other users.

Configure a Layout Sequence

➀ [Sequence Name]
Enter the name of layout sequence.

➁ [Type]
Specify the type of layout sequence.

➂ [Available Layouts]
Displays a list of available layouts.

➃ [Add Layout]
Add the selected layout to the [Sequence Layouts] list.

➄ [Move Up] and [Move Down]
Move the selected layout up or down in the list to 
change the sequence order.

➅ [Remove Layout]
Remove a layout from the list.

➆ [Sequence Layouts]
Displays a list of layouts in the order of the layout 
sequence.

➇ [Interval]
Specify the display time of each layout in the 
sequence, from 5 to 9999 seconds.

➈ [OK] and [Cancel]
Close the dialog box.

Open Multiple Layouts Using Tabs

You can open different layouts using tabs for quick 
access.

A new layout is displayed for the tab.

1 Click [Layouts] on the toolbar to display a menu for 
selecting existing layouts.

2 Select a layout.

1 Click [Layouts] > [New Layout Sequence] to display 
the [New Layout Sequence] dialog box.

2 Specify the layouts to be displayed in the sequence.

➁

➀

➂

➈➅➃ ➆

➇

➄

3 Click [OK] to close the dialog box.

1 Click [File] > [New Tab] to open a new tab.

2 Select a layout and open it in the tab (p. 68).
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Organize Layouts

You can change the display order of menus, classify and 
organize layouts in folders, and edit the layouts.

➀ Layout tree
Displays a list of created layouts.
The layout tree uses the following icons:

➁ [New Folder]
Create a new folder.

➂ [Move to Folder]
Move the selected layout to a folder.

➃ [Move Up] and [Move Down]
Move the selected layout up or down in the list.

➄ [Delete]
Delete the selected layout from the list.

➅ [Rename]
Change the name of the selected layout.

➆ [Properties]
Displays the properties of the selected layout.
The properties displayed will differ according to the 
type of layout, as described below.
(Normal) Layout: Same as the properties displayed in 

step 2 on p. 65. You can configure the 
background and the video window display.

Dynamic Layout: Same as the properties displayed in 
step 2 on p. 67. You can specify the conditions 
for displaying cameras.

Layout Sequence: Same as the properties displayed in 
step 2 on p. 68. You can specify the layouts that 
will be automatically sequenced.

➇ [Copy to Folder]
Copy the selected layout to a folder.

➈ [Close]
Close the dialog box.

Note

The settings in the [Organize Layouts and Layout Sequences] 
dialog box, such as the order of the layout sequence and the 
folder types are also displayed when you click the [Layout] menu, 
or when you click the [Layouts] button on the toolbar.

1 Click [Layouts] > [Organize Layouts] to display the 
[Organize Layouts and Layout Sequences] dialog box.

Icon Description

Custom layout

Dynamic layout

Layout sequence

Folder

➀

➈

➇
➆
➅
➄

➃

➂
➁

Important
• You cannot change the name of the [Shared Layouts] and 

[User Layouts] folders.

• Only the administrator (or a user with the required 
permissions) can manage shared folders (p. 51).
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Chapter 5
Setting a Recording 
Schedule

❏ Setting weekly schedules

❏ Configuring recording modes: continuous recording, motion detection 

recording, and sensor recording

❏ Setting special day schedules
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The camera supports sensor recording and schedule recording to internal memory. If these features are enabled, they take 
precedence over the Storage Server recording schedule. You must disable the feature on the camera before using the 
recording schedule on the Storage Server.

Flow of Recording Schedule Settings

Display the [Recording Schedules] window (p. 73)

Set a Weekly schedule Set a Special Day schedule

Select a camera (p. 73) Name the schedule (p. 88)

Set a schedule (p. 74) Specify the day (p. 89)

Select a camera (p. 89)

Configure the recording mode (p. 76)

Continuous recording (p. 76) Intelligent function recording (p. 81)

Motion detection recording (p. 78) Volume detection recording (p. 81)

Sensor recording (p. 77)

Configure the advanced recording settings (p. 82)

Camera angle (p. 82) Focus (p. 87)

Recording before or after an event (p. 84) External outputs (p. 87)

Image quality adjustment (p. 85)

Save the schedule (pp. 75, 89)

Edit, delete or copy from a schedule (p. 90)

Important

Be sure to test recording schedules before using them.
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Display the [Recording Schedules] window

The [Repeating Weekly Schedules] tab is selected 
whenever the [Recording Schedules] window is 
displayed.

➀ [Add Schedule Item], [Edit], [Delete]
Add, edit or delete a schedule item.

➁ [Zoom] slider
Zoom in and zoom out the time line of the schedule 
area.

➂ [Search for] box
Find the camera that will be assigned the recording 
schedule.

➃ Schedule area
Displays the currently registered cameras and their 
corresponding weekly schedules, arranged by day of 
the week.

➄ [Close]
Closes this window.

Select a Camera

When you have a large number of cameras registered, 
search for the camera using the camera name or any 
associated tags.

The following items are displayed when you click the 
search button.

• [Name, Tag or Status]
Enter the camera name, any associated tags, or the 
camera status in the search criteria box.

• [Camera Name]
Enter the camera name in the search criteria box.

• [Tag]
Select the camera tag to be searched.

• [Camera Status]
Select the status to be searched.

• [Camera Type]
Select the model name to be searched.

• [Host Name]
Enter the camera host name or IP address in the 
search criteria box.

• [Storage Server Group Name]
Searching by this item is not available.

Record on a Regular Basis (Repeating Weekly Schedules)

1 Click [Window] > [Recording Schedules] to display the 
[Recording Schedules] window.

➀ ➁

➂ ➃ ➄

1 Click the search button and specify the search criteria.

2 Specify the search criteria and search for the camera.

Search button

Search criteria box
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Set a Weekly Schedule

Hint
You can select more than one camera by holding down the Shift 
key or Ctrl key and clicking the cameras.

➀ Recording time settings area
Specify the day of the week and the start and end time 
of the recording period.

➁ Recording mode list
Select the recording mode.

➂ Recording settings area
Configure the settings for the recording mode selected 
in ➁.

➃ [OK] and [Cancel]
Close the dialog box.

Specify the Recording Period and Day of the 
Week

• To record for the entire day without specifying a 
start and end time, click [All Day].

• To specify a recording period, enter the start time 
in [Start Time] and the end time in [End Time]. Use 
these items when you want to specify a recording 
time that goes past midnight, such as when 
recording late into the night. Alternately, select a 
duration for the recording (minimum of 15 min.) in 
the [Duration] field.

If [Restrict Service Time] is enabled on the camera, 
recording will take place only during the service time, 
irrespective of the recording schedule.

Note

• You cannot specify overlapping recording schedules on the 
same camera.

• The time of the recording schedules is based on the Storage 
Server clock. We recommend that you synchronize the clocks 
on all the Storage Server you are using.

• If you set the operating system to automatically handle daylight 
saving time, the time will be automatically adjusted on the first 
and last days of the daylight saving time period.

1 In the schedule area, click the camera that you want to 
add the schedule to.

2 Click [Add Schedule Item] to display the [Edit Schedule 
Item] dialog box.

➀

➁ ➂ ➃

1 Specify the recording period.

2 Select the check boxes for the days of the week on 
which to repeat the recording in [Repeat On].
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Specify the Recording Mode

For example, if you want continuously record for the 
entire duration of the recording schedule, select the 
check box next to [Continuous Recording].

The settings are different for each recording mode.

• Continuous recording
Records continuously for the specified recording 
period. For details, see “Continuous Recording 
Settings” (p. 76).

• Sensor recording
Starts recording when there is a signal from a sensor 
connected to the camera. For details, see “Sensor 
Recording Settings” (p. 77).

• Motion detection recording
Starts recording when motion is detected. For details, 
see “Motion Detection Recording Settings” (p. 78).

• Intelligent function recording
Starts recording when motion that meets the intelligent 
function detection criteria is detected. For details, see 
“Intelligent Function Recording Settings” (p. 81).

• Volume detection recording
Starts recording when the volume detection criteria are 
met. For details, see “Volume Detection Recording 
Settings” (p. 81).

Intelligent function recording and volume detection 
recording are not supported.

Note
• You can specify the priority of the events generated by sensor 

recording, motion detection recording, intelligent function 
recording and volume detection recording. For details, see 
p. 77 and p. 78. When two events occur simultaneously, the 
event with the higher priority takes precedence.

• Only supports continuous recording mode.

Hint

You can specify more than one recording mode at the same time. 
For example, you can select motion detection recording and 
specify a frame rate that is higher than continuous recording. This 
way, a high frame rate is used only when motion is detected.

Specify Advanced Settings

Advanced settings are available when the [Advanced] 
button is displayed in the recording settings area. For 
details, see “Configure the Advanced Recording Settings” 
(p. 82).

Save the Recording Schedule

The schedule that was set is displayed in the 
schedule area. The schedule becomes active as soon 
as it is displayed in the schedule area.

1 Select the check box next to the recording mode in the 
list that best suits the type of recording you require.

2 Configure the recording mode settings in the recording 
settings area.

1 Click [OK] to close the dialog box.
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Configure the Recording Mode

Continuous Recording Settings

➀ [Aspect Ratio]
Specify the aspect ratio ([4:3]).
If you select [Not specified], the camera’s aspect ratio 
setting is used for recording.

➁ [Resolution]
Set the [Aspect Ratio] to [4:3] to make this setting 
available and specify the resolution ([160x120], 
[320x240], [640x480] or [1280x960]).
If you select [Not Specified] for the [Resolution], the 
camera’s resolution setting is used for recording.

➂ [Video Format]
Specify the video format ([JPEG], [MPEG-4] or 
[H.264]).
The available formats depend on the camera model.

Note

If you select [MPEG-4] or [H.264] for the [Video Format] setting, 
the [Aspect Ratio] and [Maximum Frame Rate] settings cannot 
be changed. The settings on the camera are used for recording.

Only supports [JPEG] for the [Video Format].

➃ [Maximum Frame Rate]
Specify the maximum frame rate (number of frames 
recorded in one second) in the range from 0.1 to 30 
frames per second (fps).

Note

• It may not be possible to record at the specified frame rate or 
recording may pause intermittently, depending on the load on 
the Storage Server CPU or the hard disk.

• Recording may be performed at lower than the specified frame 
rate, depending on the number of Viewers that are accessing 
the camera, the load on the camera and Storage Server, 
variation in network traffic, and the environment at the time of 
recording.

• The maximum frame rate is 5 fps.

➄ [Record audio if available]
Select this check box if you want to record audio 
together with the image.

Note

• Audio recording is enabled when the recording mode is 
selected. You cannot schedule audio-only recording.

• If [MPEG-4] or [H.264] recording format is used, the recorded 
audio will not be in sync with the recorded image. If [JPEG] 
recording format is used, the recorded audio will be in sync 
with the recorded image for the most part, however it is not 
guaranteed that it will be completely in sync.

1 Click [Continuous Recording] in the recording mode 
list and select the check box.

2 Configure the video recording settings.

Important
The size of the recording file increases as the resolution 
becomes higher. Make sure there is sufficient hard disk space 
available before specifying a higher resolution.

➀

➂

➃
➄

➅

➁

➆

Important

If you select [MPEG-4] or [H.264], the [Storage Server] option in 
the [Detect Motion Using] box cannot be selected.

Important
The size of the recording file increases as the frame rate 
becomes higher. Make sure there is sufficient hard disk space 
available before specifying a higher frame rate.

Important

Even if the [Record audio if available] check box is selected, 
audio will not be recorded if the audio sending function has not 
been activated on the camera. If you schedule a recording, 
make sure the audio sending function on the camera has been 
set to [Enable].
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➅ [Advanced]
Displays the [Advanced Recording Settings] dialog 
box. For details, see “Configure the Advanced 
Recording Settings” (p. 82).

➆ [Use the recording-mode stream]
Enable the recording stream function. With this 
function, the camera temporarily stores the image in its 
own memory before sending it to the Storage Server. 
This can help reduce the effects of non-uniform 
network traffic (jitter).

Note
• The recording-mode stream function will only work if the 

camera supports the feature and the stream can be acquired.

• If an upload function is already being used on the camera, you 
cannot use the recording-mode stream function.

• This setting is only available if [JPEG] format is specified for 
[Video Format].

• [Maximum Frame Rate] must be [10] or less when using this 
feature.

• When the recording-mode stream function is used, the 
streamed image has a higher priority than the live image. 
Depending on the load on the camera, such as the number of 
Viewers that are simultaneously connected to the camera, 
display of the live image may stop.

• You cannot select [H.264] for the [Video Format].
• You cannot select [1280x960] for the [Resolution].

• You cannot select [MPEG-4] for the [Video Format].
• When using [Use the recording-mode stream], JPEG 

images are recorded to the camera’s SD memory card 
when the network connection is interrupted. The frame 
rate of the recording is 1 fps. For details, see the 
camera manual.

The VB-C50Fi does not support [Record audio if 
available].

• You cannot select [MPEG-4] or [H.264] for the [Video 
Format].

• [Use the recording-mode stream] is unavailable.

Sensor Recording Settings

➀ [Do not record]
Select to not record even when there is a signal from 
this sensor.

Hint

You can individually enable or disable recording for each sensor. 
For example, you may not want to record when there is door 
sensor signal, but to start recording when there is a window 
sensor signal.

➁ [Start Recording]
Start recording when there is a signal from the sensor. 
After selecting the item, configure the recording 
settings below the item.

➂ [Priority]
Select the event priority. For details, see “Check 
Events” (p. 104).

➃ [Invert this event]
Start recording when there is no signal from the sensor, 
and stop recording when a signal is present.

1 Click [Sensor Recording] in the recording mode list 
and select the check box.

2 Configure the image and event settings.

➀
➁
➂

➃
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The other settings are the same as those for continuous 
recording. For details, see “Continuous Recording 
Settings” (p. 76).

Note

• The number of tabs depends on the number of compatible 
external devices (sensors) that are connected to the camera.

• The name of the external device that is registered in the 
camera is displayed in the [Sensor Name] box.

• If two sensor recording schedules with the same priority are 
set, the schedule that is triggered first takes precedence. If the 
second schedule is still present when the first schedule ends, 
the second schedule will start recording.

Motion Detection Recording Settings

Using the Camera for Motion Detection

➀ [Do not record]
Select this item if you do not want recording to start 
when motion is detected.

Hint
You can use this setting to individually enable or disable 
recording for each area. For example, you may want to record 
when motion is detected around a vault, but not record when 
motion is detected around an entrance.

➁ [Start Recording]
Start recording when motion is detected.

➂ [Priority]
Select the event priority. For details, see “Check 
Events” (p. 104).

Important

• When you select the [Sensor Recording] check box in the 
recoding mode list in step 1, [Do not record] is selected for 
all of the sensors. You must select [Start Recording] for at 
least one sensor to be able to start sensor recording.

• The sensor inputs can generate a large number of events for 
the Storage Server, thereby increasing the load on the 
server. For reference, if the Storage Server is continuously 
receiving more than 10 events per minute, we recommend 
that you use continuous recording mode.

• If the recording period for a schedule ends while sensor 
recording is in progress, recording will stop.

Important
The motion detection feature is not suitable for applications 
where high reliability is required. We recommend that you do 
not use the motion detection feature in applications such as 
surveillance, which require high reliability. Canon cannot take 
responsibility for any accidents or damages associated with 
using the motion detection feature.

1 Click [Motion Detection Recording] in the recording 
mode list and select the check box.

2 Select [Camera] in the [Detect Motion Using] box.

3 Configure the recorded image and event settings on 
each area tab.

➀
➁
➂
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The other settings are the same as those for continuous 
recording. For details, see “Continuous Recording 
Settings” (p. 76).

To use motion detection, you must create a schedule with 
motion detection using the camera’s schedule setting 
tool.

Note
• If the camera supports four motion detection areas, tabs 

named [Area 1] through [Area 4] are displayed in the 
recording settings area. You can specify settings individually 
for each motion detection area.

• The [Area Name] box displays the name of the area that is 
registered in the camera.

• To use a camera for motion detection, you must configure the 
motion detection settings on the camera. For details, see the 
camera manual.

• When using the camera for motion detection with more than 
one motion detection area, you can specify the event priority 
for each area.

• Motion detection is suspended when the camera is panning, 
tilting or zooming, irrespective of the motion detection settings.

• If motion is detected in multiple motion detection areas that 
have the same priority, recording will start with the area having 
the lowest number.

Using the Storage Server for Motion Detection

Note
If you select [MPEG-4] or [H.264] in [Video Format], the [Storage 
Server] option in the [Detect Motion Using] box cannot be 
selected. Note also that if you select [MPEG-4] or [H.264] in other 
recording modes besides motion detection recording, the 
[Storage Server] option still cannot be selected.

[Recording Settings] tab

➀ [Priority]
Select the priority of the motion detection events. For 
details, see “Check Events” (p. 104).
The other settings are the same as those for continuous 
recording. For details, see “Continuous Recording 
Settings” (p. 76).

Hint
You can use this setting to individually enable or disable 
recording for each area. For example, you may want to record 
when motion is detected around a vault, but not record when 
motion is detected around an entrance.

[Settings] tab

➀ [Analysis Frame Rate]
Specify the motion detection frame rate (frames per 
second).

Important

The load on the Storage Server CPU increases when motion 
detection is performed on the Storage Server. We strongly 
recommend that you use the motion detection on the camera, if 
it is available.

1 Click [Motion Detection Recording] in the recording 
mode list and select the check box.

2 Select [Storage Server] in the [Detect Motion Using] 
box.

3 Configure the recorded image and event settings on 
the [Recording Settings] tab.

4 Configure the motion detection settings on the 
[Settings] tab.

➀

➀

➂

➃

➄

➅

➁

➆
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➁ [Settings Mode]

• [Simple]
[Sensitivity] and [Area Ratio] can only be set using 
the sliders. [Duration] is fixed at 0.2 seconds.

• [Advanced]
Makes the [Sensitivity], [Area Ratio] and [Duration] 
boxes available so that values can be entered.

➂ [Sensitivity]
Specify the motion detection sensitivity within the range 
of 1 to 256. Increase the number to increase the 
sensitivity.

➃ [Area Ratio]
Specify the area of the preview video that the Storage 
Server uses for motion detection. The range is 0 to 
100%. The size marker inside the Detection Indicator 
changes position depending on the value of this 
setting.

➄ [Duration]
Specify the length of time the motion signal must be 
present to decide that there is motion. The range is 0 to 
5.0 seconds.

➅ [Active Region]
Displays a preview video from the camera used for 
motion detection.
Displays a dotted-line frame representing the active 
region on top of the preview video. Drag the frame 
handles to make it larger or smaller.

➆ [Detection Indicator]

The size marker changes position depending on the 
value of the [Area Ratio] setting. Adjust the motion 
detection settings while viewing the preview video and 
the Detection Indicator.
The colored bar changes depending on the value of 
the [Sensitivity] and the [Area Ratio] settings.

Use intelligent function recording instead of motion 
detection recording.

You cannot specify motion detection on the camera.

Color of the 
Colored Bar

Meaning

Green The detected motion does not exceed the 
values specified in [Sensitivity] and [Area 
Ratio]. In this case, the colored bar remains 
to the left of the size marker.

Red The detected motion exceeds the values 
specified in [Sensitivity] and [Area Ratio]. In 
this case, the colored bar remains to the 
right of the size marker.

Size marker

Colored bar

Important
• If the recording period for a schedule ends while motion 

detection recording is in progress, recording will stop.

• The detection indicator is not affected by the [Duration] 
setting. Be sure to take the detection time into account when 
adjusting the motion detection settings.

• To perform motion detection on the Storage Server, you must 
specify [JPEG] for the [Video Format]. Also, if you 
simultaneously use more than one recording mode, all the 
[Video Format] settings must be [JPEG]. An error message is 
displayed if you try to use a format other than [JPEG] and 
motion detection on the Storage Server at the same time.

• Make the [Priority] setting on the [Recording Settings] tab 
lower than the priority of any of the other recording settings.

• It may take approximately 30 sec. for 
exposure, night mode and white balance settings to be 
reflected in the view after recording starts.
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Intelligent Function Recording Settings

➀ [Do not record]
Do not record when the conditions for this rule are met.

➁ [Start Recording]
Start recording when the conditions for this rule are 
met. After selecting the item, configure the recording 
settings below the item.

➂ [Priority]
Select the event priority. For details, see “Check 
Events” (p. 104).

The other settings are the same as those for continuous 
recording. For details, see “Continuous Recording 
Settings” (p. 76).

This feature is not supported.

Note
• Tabs named [Rule 1] through [Rule 15] are displayed, as 

shown. Each tab can be configured individually.

• The name of the rule is displayed in [Rule Name].

Hint

To use intelligent function recording, you must configure the 
intelligent function recording settings on the camera. For details, 
see the camera manual.

Volume Detection Recording Settings

➀ [Do not record]
Do not record when audio is detected.

➁ [Start Recording]
Start recording when audio is detected. After selecting 
the item, configure the recording settings below the 
item.

➂ [Priority]
Select the event priority. For details, see “Check 
Events” (p. 104).

The other settings are the same as those for continuous 
recording. For details, see “Continuous Recording 
Settings” (p. 76).

This feature is not supported.

Hint
To use volume detection recording, you must first configure the 
volume detection recording settings on the camera. For details, 
see the camera manual.

1 Click [Intelligent Function Recording] in the recording 
mode list and select the check box.

2 Configure the recording and event settings on each 
rule tab.

Important

If the recording period for a schedule ends while intelligent 
function recording is in progress, recording will stop.

➀
➁
➂

1 Click [Volume Detection Recording] in the recording 
mode list and select the check box.

2 Configure the recording and event settings.

Important
If the recording period for a schedule ends while volume 
detection recording is in progress, recording will stop.

➀
➁
➂
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Configure the Advanced Recording Settings

Click [Advanced] in the recording mode settings area to 
display the [Advanced Recording Settings] dialog box 
and configure the operation when recording starts.

➀ [Camera Angle]
Specify the camera angle for recording.

➁ [Image Adjustment] tab
Adjust the image quality.

➂ [Focus] tab
Adjust the focus.

➃ [External Outputs] tab
Enable or disable output to external devices registered 
on the camera.

➄ [Recording Options]
Specify the duration of recording before and after an 
event.

➅ [OK] and [Cancel]
Close the dialog box.

Specify the Camera Angle for Recording

➀ [Not Specified]
Select this item when you do not want to specify the 
camera angle.

➁ [Custom]
Specify the camera angle using the [Preview] window.

Drag the slider to change the camera zoom and click 
or drag inside the video to change the camera angle.

➂ [Presets]
Select the camera angle from the list of preset camera 
angles registered in the camera.

➃ [Preset Tour]
Move the camera through a series of preset camera 
angles while recording. Click [Settings] to display the 
[Preset Tour Settings] dialog box, and then specify the 
order of the presets.

[Preset] and [Preset Tour] are unavailable.

[Preset Tour] is unavailable.

If you use the digital zoom when setting the preset angle 
with the camera, the viewing angle seen when the setting 
is made and the viewing angle that will be recorded may 
be different.

➀ ➂ ➃

➄ ➅

➁

➀

➂

➃

➁
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If you initialize the head position (the camera points the 
head forward, reinitializes, and then returns the head to 
the former position) during recording, the image during 
the movement of the head will also be recorded.

When an external camera is connected and [Use External 
Video Input] is enabled, the settings on this dialog box are 
unavailable.

Note

• Clicking the [Settings] button alone does not perform a preset 
tour. You must first configure the settings in the [Preset Tour 
Settings] dialog box.

• You are not able to specify preset and camera angles when 
configuring the intelligent function or motion detection settings, 
or when configuring multiple cameras.

• To be able to select [Preset] or [Preset tour], you must first 
register camera angle presets on the camera. For details, see 
the camera manual.

Configuring a Preset Tour
Select [Preset Tour] in the [Camera Angle] settings and 
specify the order of the presets that are registered in the 
camera.

The tour starts with the first preset and proceeds 
down the list. Change the order by selecting a preset, 
and then clicking [Move Up] or [Move Down].
To remove a preset, select the preset and click 
[Remove]. To edit a preset in the list, select the preset 
and click [Edit].

1 Click [Settings] to display the [Preset Tour Settings] 
dialog box.

2 Click [Add] to open the [Edit Preset Tour] dialog box.

3 Select a preset from the [Preset] list.

4 Configure the speed and pause settings using the 
sliders ([Speed (PT)], [Speed (Z)], and [Pause (sec)]).

5 Click [OK].

6 Repeat steps 2 to 5 for additional presets.

7 Specify the order of the presets.
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You can return the focus of the camera to its default 
setting by selecting [Return to default focus when the 
camera is operated].

Note

The camera returns to the first preset position after reaching the 
last preset position.

Hint
Click [Start Test] to run through the preset tour once to confirm 
your settings.

About the Warning Message Displayed During the 
Preset Tour
Depending on the preset tour settings, a warning 
message about the camera’s pan/tilt mechanism may be 
displayed when you click [OK] to close the [Preset Tour 
Settings] dialog box. If this happens, consider changing 
the settings according to the following guidelines.
The pan/tilt mechanisms have a lifetime of approximately 
100,000 round trips over the full range of motion 
(according to our estimates).

Specify the Option for Recording Before and/or 
After an Event

You can record a number of seconds before and/or after 
an event, such as sensor input or motion detection, using 
the [Recording Options] setting.

➀ [sec. before event]
Number of seconds to record before an event (max. 30 
seconds).

➁ [sec. after event]
Number of seconds to record after an event (max. 999 
seconds).

Note

• [Recording Options] cannot be specified when setting 
continuous recording.

• Even if [sec. before event] and [sec. after event] are both set to 
0, recording will continue when events are continuously 
generated.

• The higher the value for [sec. before event] the greater the 
memory usage for the Storage Server. If the Storage Server 
has insufficient memory, the server will run out of virtual 
memory, which consumes hard disk space, significantly 
reducing processing performance.

• If you specify a preset camera angle for sensor recording, the 
camera angle will change to the preset angle when sensor 
recording starts. Therefore, the camera angle of the recording 
before the sensor recording event will be different from the one 
after the event. If [Recording Options] is set to record zero 
seconds after an event and the sensor input is very short, 
recording may stop before the camera reaches the preset 
camera angle.

8 Click [OK] to close the dialog box.

Important

• Using preset tour with MPEG-4 or H.264 format will consume 
a large amount of disk space.

• The preset tour settings can effect the durability of the 
camera’s pan/tilt mechanism.

➀

➁
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Adjust the Image Quality

[Image Adjustment] tab

➀ [Exposure]
The settings change according to the selected 
exposure setting.

• [Not Specified]
Use the camera’s exposure setting.

• [Auto]
Automatically control the exposure.

• [Auto (Flickerless)]
Reduce flicker from light sources, such as 
fluorescent lighting. The shutter speed is 
automatically adjusted according to the lighting 
conditions.

• [Auto (Shutter Priority)]
Specify the shutter speed.

The following exposure compensation setting is 
displayed when [Auto], [Auto (Shutter Priority)] or [Auto 
(Flickerless)] is selected.

[Compensation]: Specify exposure compensation 
using seven levels, from -3 to +3, or [Not 
specified]. Select negative values to darken the 
image and positive values to lighten the image.

[Metering Mode]: Specify the metering mode setting: 
[Center-weighted], [Average], or [Spot].

[Shutter]: Specify the shutter speed when [Exposure] 
is set to [Auto (Shutter Priority)] using 12 levels, 
from 1/8 to 1/8000 seconds.

Important

The settings may be different for different camera models. For 
details, see the camera manual.

➀

➂

➃

➁

Metering mode Description

Center-weighted Meters the entire image, focusing on the 
center of the image. A correct exposure is 
obtained for a subject near the center of the 
image, even though the periphery may be 
slightly darker or lighter. Use for subjects 
that are in the center of the image.

Average Meters an average of the entire scene. 
A uniform exposure is obtained even when 
the scene has significant differences in 
brightness. Use for scenes where, for 
example, cars are passing through or 
people are entering and exiting.

Spot Meters the center of the scene. 
The correct exposure is obtained for a 
subject near the center of the scene, 
irrespective of the brightness of the 
periphery. Use if the subject is lit by a 
spotlight or is backlit, where the exposure 
should be adjusted to the center of the 
scene.
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• [Manual]
Compensate for the exposure manually. The 
following exposure compensation settings are 
displayed.

[Iris]: Specify the iris setting. Drag the slider to the left 
to close down the iris and make the image 
darker or to the right to open up the iris and 
make the image brighter.

[Shutter]: Specify the shutter speed using 15 levels, 
from 1/1 to 1/8000 seconds.

[Gain]: Specify the gain (sensitivity to brightness). 
Drag the slider to the left to decrease the gain 
and make the image darker or to the right to 
increase the gain and make the image brighter.

➁ [Smart Shade Control]:
Specify a value to use for the camera’s smart shade 
control feature when recording. Select one of seven 
levels, from 1 (weakest) to 7 (strongest), or [Not 
Specified]. If [Not Specified] is selected, the camera’s 
smart shade control setting is used for recording. To 
disable smart shade control, select [Off].

➂ [Aperture Mode]
Specify the camera aperture mode.

[Night Mode]

• [Not Specified]
Use the camera’s night mode function settings.

• [Disabled]
Disable the night mode function.

• [Enabled]
Record in night mode.

• [Auto]
The camera automatically decides when to switch to 
night mode. When recording ends, the night mode 
setting returns to the value before recording started.

➃ [White Balance]
Specify the appropriate white balance by selecting one 
of the camera’s light source settings displayed in the 
list.
If [Manual] is selected, use one of the following two 
methods to adjust the white balance.

• [R Gain] and [B Gain]
Specify the white balance parameters by dragging 
the sliders. Drag to the right to increase the gain (the 
sensitivity to brightness).

• [One Shot WB]
Force white balance adjustment to a light source. 
Using a white object (such as piece of white paper) 
as a standard, fill the shot with the object and click 
this button.

The Smart Shade Control feature is not supported.

 [Auto] is unavailable for [Aperture Mode].

Note
When [Night Mode] is enabled in [Aperture Mode], both the 
display and recorded video are in black and white.

Important
If you select [Enabled] for Night Mode, you will not be able to 
set the white balance. If you select [Auto] for Night Mode, 
however, you will be able to set the white balance, but those 
settings will be cleared when the camera switches to Night 
Mode.
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Adjust the Focus

[Focus] tab

Note
The settings are different for different camera models. For details, 
see the camera manual.

➀ [Not Specified]
Record using the existing focal position of the camera.

➁ [Auto] and [Auto (for domes)]
Automatically focus the image.
Use [Auto (for domes)] for cameras equipped with an 
indoor dome housing. The setting prevents the camera 
from focusing onto the dome surface.

➂ [Fixed at infinity]
Fix the focal point at infinity.

➃ [Manual]
Adjust the focus manually by clicking the [Far] or 
[Near] button.
Click [One Shot AF] to focus once on the current 
subject and then return to manual focus.

Configure External Outputs

[External Outputs] tab

Enable or disable output to external devices registered on 
the camera when the recording schedule starts.

➀ [Not Specified]
Disable the external output.

➁ [On]
Enable the external output.

Note

• You must first specify the external device settings on the 
camera. For details, see the camera manual.

• The number of external outputs is different for different camera 
models.

• The external outputs are enabled only during recording.

Hint

This feature can be used with sensor recording, motion detection 
recording, intelligent function recording or volume detection 
recording. For example, by connecting a buzzer to an external 
output and enabling the output for motion detection recording, 
the buzzer will sound when motion is detected.

➀

➁

➂
➃

➀

➁
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Use special day schedules to record on exceptional days, 
such as public holidays.

Display the [Special Day Schedules] Tab

➀ Special day schedule type
Add, edit or delete a special day schedule type.

➁ [Storage Server Group]
Display the Storage Server Group name.

➂ Special day schedule settings

• [Add], [Edit], and [Delete]
Add, edit or delete a special day schedule.

• [Use Repeating Weekly Schedule]/[Not Use 
Repeating Weekly Schedules]
Enable or disable the special day schedule for the 
applicable day of the weekly schedule registered on 
the selected camera.

• [Copy from Repeating Weekly Schedule]
Specify a day of an existing weekly schedule 
registered on the selected camera, and import it as 
a special day schedule.

➃ [Zoom] slider
Zoom in and zoom out the timeline of the schedule 
area.

➄ Days area
Specify the day for the special day schedule selected 
in ➀.

➅ Camera search
Find the camera that will be assigned the schedule.

➆ Schedule area
Displays the currently registered cameras and their 
corresponding recording schedules by day.
This area also has a search function for finding 
cameras using search criteria, such as the camera 
name or tags. For details, see “Select a Camera” 
(p. 73).

➇ [Close]
Close this window.

Note
A special day schedule takes precedence over a weekly 
schedule.

Create a Special Day Schedule

Special Day recording schedules are set by the day.

The name is added to the schedule type area.

Note

Before deleting a schedule name from the schedule type area, 
first delete the applicable day from the days area.

Record at Specific Times (Special Day Schedule Settings)

1 Click [Window] > [Recording Schedules] to display the 
[Recording Schedules] dialog box.

2 Click the [Special Day Schedules] tab.

➀ ➂ ➃

➄ ➅ ➆ ➇

➁

1 Click [Add] in the schedule type area.

2 Enter the name of a special day schedule and click 
[OK].
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Specify the Day for the Special Day Schedule

Note
• Special day schedules can only be set for a one-day time 

period (00:00 to 24:00). For example, for a three-day long 
weekend (Saturday, Sunday and Monday) you will need to set 
a separate schedule for each of the three days.

• You cannot apply different special day schedules to the same 
day.

Select a Camera

For details, see “Select a Camera” (p. 73).

Specify the Recording Settings

The setting items are the same as those for the [Edit 
Schedule Item] dialog box. For details, see “Set a 
Weekly Schedule” (p. 74).

Specify Advanced Settings

Advanced settings can be configured when the 
[Advanced] button is available in the recording settings 
area. For details, see “Configure the Advanced Recording 
Settings” (p. 82).

Save the Recording Schedule

The schedule is displayed in the schedule area. The 
schedule becomes active as soon as it is displayed in 
the schedule area.

1 Click the schedule name you want to use in the 
schedule type area.

2 Click [Add] in the days area.

3 Specify the date for the special day schedule on the 
calendar and click [OK].

1 Select the schedule name in the schedule type area.

2 Specify the day to assign to the special day schedule 
in the days area.

3 Select the camera you want to use in the schedule 
area and click [Add].

4 Specify the special day schedule.

1 Click [OK] to close the dialog box.

Important
When you assign a special day schedule to a number of 
cameras, the weekly schedules assigned to the remaining 
cameras for the special day are disabled. To reapply the 
weekly schedules for that day to the remaining cameras, import 
the weekly schedule for the day of the special day schedule. 
For details on importing a weekly schedule, see “Import from a 
Weekly Schedule” (p. 90).
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Editing a Recording Schedule

For details on the settings in the [Edit Schedule Item] 
dialog box, see “Set a Weekly Schedule” (p. 74).

Delete a Recording Schedule

The recording schedule is deleted.

Import from a Weekly Schedule

You can create a special day schedule for any day of the 
week by importing it from a weekly schedule.
You can also import a schedule whose day of the week is 
the same as the desired day, or you can directly specify 
the day of the week.

Import from a Weekly Schedule with the Same 
Day of the Week

When you click the button, its name changes to [Not 
Use Repeating Weekly Schedules] and any weekly 
schedules registered on the camera become semi-
transparent. Click [Not Use Repeating Weekly 
Schedules] to stop the semi-transparent display.

Edit a Recording Schedule

1 Select the recording schedule you want to edit in the 
schedule area, and click [Edit].

2 Change the settings of the recording schedule.

3 Click [OK] to close the dialog box.

1 Select the schedule that you want to delete in the 
schedule area.

2 Click [Delete].

1 Select a camera in the schedule area.

2 Click [Use Repeating Weekly Schedule].

Important

• If you use [Use Repeating weekly Schedule] to import a 
weekly schedule to a schedule that already has a special day 
schedule, the imported schedule will overwrite the existing 
schedule.

• You cannot edit a weekly schedule that was imported using 
[Use Repeating Weekly Schedule] on the [Special Day 
Schedules] tab. To modify an imported weekly schedule, 
make a copy of it by referring to “Import by Specifying the 
Day of the Week” (p. 91).
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Import by Specifying the Day of the Week

You can copy from a weekly schedule by specifying the 
day of the week to copy. Using this procedure, you are 
able to edit the recording schedule after making the copy.

Hint

Importing by specifying the day of the week can be used to 
import the schedule for any of the days of the week contained in 
the weekly schedule. For example, you can import the schedule 
of a day of the week that is different from the day of the week of 
the target day.

1 Select a camera in the schedule area.

2 Click [Copy from Repeating Weekly Schedule].

3 Select a day of the week and click [OK].
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Chapter 6
Day-to-Day Operations

❏ Viewing live images

❏ Playing recordings

❏ Operating a camera

❏ Changing the layout of a video window

❏ Viewing and checking events
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Flow of Operations

View recorded images

Record Now (p. 96) Play a recording (p. 98)

Save a snapshot of the displayed image (p. 96) Save part of a recording (p. 99)

Search for a recording (p. 97) Zoom in/out of the Viewer display (p. 99)

View live images 

Get control of a camera (p. 100) Change the camera angle using a panorama image (p. 102)

Use the pan/tilt/zoom feature (p. 100) Play back audio (p. 102)

Change the camera angle to a preset position (p. 101) Compensate for dark regions in the image (p. 103)

Check events

View a live event (p. 104) Search for events (p. 105)
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➀ Menu bar and toolbar
Access this software’s functions. The toolbar provides easy access to commonly used functions.

➁ Video window
Display live images from a camera or playback from a recording.

➂ [Panorama]
Change the camera angle using a panorama image.

➃ Viewing area
Place a video window in this area. You can display a grid for arranging video windows.

➄ Timeline
Display the time and date and events that have occurred. Click an event to play back the recording.

➅ Status bar
Displays Viewer status messages and CPU load.

➆ [Audio]
Listen to live audio and transmit audio using the camera’s two-way audio feature.

➇ [Camera Selector]
Display and select cameras added to the Storage Server Group.

➈ [Live Events Log]
Display events that occurred one hour or less after Viewer startup.

➉ [Camera Control]
Get control of the camera and change the camera angle.

Viewer Features

➆

➇

➉

➈

➀

➁

➂

➃

➄

➅
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Record Now

Start recording while watching the live image. The 
recording format is JPEG.

A white frame surrounding the selected video window 
is displayed.

Recording starts. The upper part of the window is red 
when recording. Recording stops automatically after 
the set time period.

The maximum frame rate is 5 fps.

Note
• Audio is also recorded if audio is available from the camera.

• The [Record Now] duration can be changed. For details, see 
“Configure the Viewer Display and Operation Settings” (p. 57).

Hint

You can use [Record Now] to immediately record during a period 
where there is no recording schedule set.

Save a Snapshot of the Displayed Image

You can take a snapshot of the displayed image and save 
the still image.

➀ [Display camera name] check box
Select this check box if you want to add the camera 
name to the still image.

➁ [Display timestamp] check box
Select this check box if you want to add the time and 
date to the lower right side of the saved still image. 
(You cannot specify the position, font, size or color.)

➂ [Save As]
Save the preview video.

➃ [Cancel]
Closes the dialog box.

The [Save As] dialog box appears.

The file is saved in the specified location and the 
focus is placed on the [Capture Still Frame] dialog 
box again.

If you use the on screen display feature of the camera, the 
date and time on the snapshot may look different from the 
date and time on the on screen display. In addition, we 
recommend that you set the camera to display characters 
on the upper right or upper left.

View Recorded Images

1 Click the video window displaying the image to be 
recorded.

2 Click [Record Now] on the toolbar.

Important

• [Record Now] records at the maximum frame rate. Be sure to 
take into account how much hard disk space is used.

• The recording duration can be specified, however, the actual 
duration may depend on various settings and on network 
delay.

1 Click [Capture] on the toolbar to display the [Capture 
Still Frame] dialog box.

2 Set the still image to be saved.

3 Click [Save As].

4 Specify the file name and storage location and click 
[Save].

5 Click [Cancel] to close the dialog box.

➀

➂

➁

➃
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Note
• You cannot operate the preview when displaying the [Capture 

Still Frame] dialog box. You must operate the camera in 
advance to set its angle. For details on operating the camera, 
see “Operate the Camera” (p. 100).

• The .bmp file format is used for still images.

Search for a Recording

Images recorded using a recording schedule or [Record 
Now] are displayed on the timeline as events. You can 
search through the recordings to find the recording that 
you want to play back.

Search by Changing the Timeline

➀ Slider
Zoom out or zoom in the timeline.

➁ Event display area
Displays events according to the times they occurred.

➂ Time bar
Drag the bar to scroll through the timeline.
Change the recording period displayed in the timeline 
using the buttons at each end.

Events displayed as film icons are videos recorded for 
that period. Click the event to play the recording.
Events associated with the selected camera are also 
displayed in the event display area. (The color of these 
events represents their priority.) Click the event to play the 
recording.

Note

• Events in the display area that are not associated with the 
selected camera (secondary events) are displayed as 
transparent. If you do not select a camera, all events are 
displayed as primary events (not transparent).

• Click [View] > [Timeline] to display/hide the timeline.

Search by Specifying the Time and Date

The playhead moves to the specified date and time 
and the recorded video starts playing in the video 
window.

Search by Event

Click [Search] on the toolbar or [Search] on the timeline 
toolbar to search for an event. Click the event in the 
search results to play the associated recording. For 
details, see “Play Back an Event” (p. 105).

Important
Do not specify the Windows folder or the Program Files folder 
on the system drive as the destination. Images cannot be saved 
to these folders.

1 Click the video window.

2 Drag the timeline to display the time and date for the 
recording.

Button Description

Go back one week

Go back one day

Go back 10% of the current time display

Go forward 10% of the current time display

Go forward one day

Go forward one week

➀ ➁

➂

3 Click an event in the event display area.

1 Click a video window.

2 Click [Jump] on the timeline to display the [Jump to 
Time] dialog box.

3 Specify the date and time and click [OK].

Events not associated with 
the selected camera.

Recording
Events associated with 
the selected camera
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Play a Recording

Use the playback controls on the timeline to control the 
image displayed in the video window.

➀ Playback controls
Controls for image playback.

➁ Event display area
Click to move the playhead to the playback position.

➂ Playhead
Drag the playhead to change the playback position.

Video Window Display for Playback

➀ Playback indicator
Displays the playback status.

➁ Title bar
Displays the camera name and the time and date of the 
recording.

Note
• You can play recordings from more than one camera at the 

same time.

• You can display recordings from one camera in multiple video 
windows. You can also play images recorded at different times 
simultaneously.

• Click [Live] on the timeline toolbar during playback to return to 
the live image.

Button Description

Jump to previous event

Rewind (each click changes the speed in 
sequence: 1x, 2x, 5x, 10x)

Go to previous frame

/ Play/pause

Go to next frame

Fast forward (each click changes the 
speed in sequence: 2x, 5x, 10x) 

Jump to next event

➀

➁

➂

➀

➁

Important
• You cannot use rewind or go to previous frame for recordings 

in MPEG-4 or H.264 format. Also, the fast forward speed is 
fixed at 2x.

• Because image data is being sent from the Storage Server to 
the Viewer during playback, playback response and 
smoothness depends on factors such as the amount of 
network traffic.

• The time displayed on the timeline corresponds to the clock 
on the computer where the Viewer is running.

• To play back a recorded video, set a time earlier than the 
current time that will allow recording 10 frames*. If you try to 
simultaneously record and play back video before 10 frames 
have been recorded, playback may be momentarily 
interrupted.
* At a recording frame rate of 0.1 fps, 10 frames takes 

100 seconds.
At a recording frame rate of 1 fps, 10 frames takes 
10 seconds.
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Zoom the Viewing Area In and Out

You can zoom the viewing area in and out in four levels. 

Each click zooms further in on the viewing area.

Each click zooms further out of the viewing area.

Note
• Select [Actual Size] from the [View] menu to return the view to 

the actual size.

• You cannot zoom out further than the actual size.

Save Part of a Recording

You can save a part of a recording with a length of up to 
one hour to a file.

➀ [From] and [To]
Specify the date and time of the start and end 
positions.

➁ [Include audio if available] check box
Clear the check box if you do not want to include audio 
in the file.

➂ [OK] and [Cancel]
Close the dialog box.

The [Save As] dialog box appears.

Note
Extracted images are saved in QuickTime format (with the .mov 
file extension) and can be played with QuickTime Player (or other 
players that support the .mov file format). If QuickTime Player is 
not installed, you can download it for free from http://
www.apple.com/quicktime. We recommend that you use 
QuickTime Player Version 6.5.1 or later.

1 On the toolbar, click [+] next to [Zoom].

2 Click [-] to zoom out.

Important
The quality of the video image in the video window decreases 
when you zoom in. To increase the image quality, increase the 
resolution (p. 61).

1 Select a recording on the timeline.

2 Click [Extract] on the timeline to display the [Extract 
Video] dialog box.

3 Specify the time range for the image to be extracted.

4 Click [OK].

5 Specify the file name and storage location and click 
[Save].

Important

• You can extract a video from only one video window at a 
time.

• Do not specify the Windows folder or the Program Files folder 
on the system drive as the destination. Images cannot be 
saved to these folders.

• You cannot save only audio data.

• If you try to extract a time range that contains different video 
formats (such as JPEG and H.264), only the first video in the 
time range will be saved.

➀

➂

➁
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You can change the camera angle or adjust the image 
quality for a camera in the video window.

Get Control of a Camera

➀ Camera angle control buttons
Change the camera angle.

➁ [Select Preset]
Moves the camera to a preset position.

➂ [Panorama]
Displays the [Panorama] window. Move the camera to 
a position using the panorama image.

➃ [Control]/[Release]
Get or release control of the camera.

➄ Zoom slider
Drag to change the zoom position. Drag up to move 
towared the telephoto position and down to move 
towared the wide-angle position.

➅ [Advanced]
Configure the camera’s advanced settings.

You now have control of the camera for a certain 
period.

Note
• If the camera is idle for one minute, camera control is released 

automatically. A count down message is displayed 10 seconds 
before the release. If you want to keep control of the camera, 
click the video window.

• If you want to move the video window while you are in control 
of the camera, drag the title bar.

• You can also control the camera while recording. If the camera 
angle to be used during recording has been set, the camera 
returns to the set position when the Viewer releases camera 
control.

Use the Pan/Tilt/Zoom Feature

Use the Pan/Tilt/Zoom Feature in the [Camera 
Control] Dialog Box

You can use the pan/tilt/zoom feature in the [Camera 
Control] dialog box after getting control of the camera.

➀ Camera angle control buttons
Change the camera angle by clicking the buttons.
Click in the center to point the camera to the front.

➁ Zoom slider
Drag the slider to change the zoom position.
Drag the slider up to move towared the telephoto 
position and down to move towared the wide-angle 
position.

Operate the Camera

1 Click the video window.

2 Click [Window] > [Camera Control] to display the 
[Camera Control] dialog box.

3 Click [Control].

➀

➄

➅

➁

➂

➃

➀

➁



Operate the Camera

101

D
ay-to-D

ay O
perations

6

Use Pan/Tilt/Zoom from the Video Window

You can also use the pan/tilt/zoom feature from the video 
window.

➀ Display area
Drag on the area to change the camera angle. Click on 
the area to move the camera angle to that point.

➁ Zoom slider
Change the zoom position using the slider or [+]/[-]. 
Click [+] or drag the slider up to move toward the 
telephoto position. Click [-] or drag the slider down to 
move toward the wide-angle position.

Pan/tilt/zoom is unavailable.

Pan/tilt is unavailable.

Zoom is unavailable when the camera’s digital zoom is set 
to [Disable].

Pan/tilt/zoom is unavailable if a fixed camera or an 
external camera, such as the VC-C50i, is used.

Change the Camera Angle to a Preset 
Position

You can select a preset camera angle in the [Camera 
Control] dialog box after getting control of a camera.

Note

You must first configure the presets on the camera before using 
this feature. For details, see the camera manual.

➀ ➁
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Change the Camera Angle Using a 
Panorama Image

Change the camera angle by specifying a position on a 
panorama image.

The frame is yellow when you have control of the 
camera. Drag the frame to change its size and zoom 
the camera in/out.
Drag the center of the frame to move the frame and 
change the camera angle.
If you draw a rectangle anywhere on the panorama 
image, the frame is redrawn at that location and the 
camera angle and zoom change correspondingly.
The frame is blue when you do not have control of the 
camera.

A panorama image is not available.

Note
You must first register a panorama image on the camera before 
using this feature. For details, see the camera manual.

Play Back Audio

If the audio feature on the camera is used, you can play 
audio using the audio panel or send audio using a 
microphone.

The [Audio] panel appears.

Options view

➀ [Listen to Audio]
Starts audio playback.

➁ [Use Microphone]
Starts audio transmission.

➂ Show options button
Displays the options for the [Audio] panel.

➃ [Play audio also while using microphone]
Select if you want to play audio even when using a 
microphone.

➄ [Use silence detection to reduce network traffic]
Select if you want to detect silent segments when 
sending audio. Decreases the amount of data 
transmitted during silent segments to decrease the 
load on network bandwidth.

1 Click [Panorama] in the [Camera Control] dialog box to 
display the [Panorama] window.

2 Change the camera angle and zoom using the frame 
displayed on the panorama image.

Important
You cannot send and receive audio from multiple Viewers 
simultaneously.

1 Click [Window] > [Audio Panel].

➀

➁

➂

➃

➄

➅

➆
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➅ [Settings]
Displays the [Silence Detection Settings] dialog box.

➆ Hide options button
Hides the options of the [Audio] panel.

Cannot send live audio from the RM Viewer. To send live 
audio, use the Administrator Viewer included with the 
camera.

 Silence Detection Settings

Select the [Use silence detection to reduce network 
traffic] check box on the [Audio] panel to set the silence 
detection sensitivity.
Click [Settings] to display the [Silence Detection Settings] 
dialog box and adjust the silence detection sensitivity.

➀ [Use the default sensitivity settings]
Uses the default sensitivity for silence detection.

➁ [Set the sensitivity manually]
Drag the slider to set the detection sensitivity.

➂ [OK] and [Cancel]
Close the dialog box.

Compensate for Dark Regions in the Image

Use the viewer shade control to compensate for any dark 
regions in the image.

• [Off]
Disable the shade control.

• [Low]/[Medium]/[High]/[Very High]
Enable the shade control. View the video window and 
select a compensation value that gives the appropriate 
brightness.

Note

• You cannot apply this feature to more than one video window.

• The viewer shade control is a feature of the Viewer, not the 
camera. Therefore, it can be used for both live and recorded 
video playback.

1 Click the video window menu button to display the 
menu.

2 Click [Viewer Shade Control] and select the amount of 
shade from the submenu.
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View a Live Event

You can display past events in the [Live Events Log] 
window.

When the Viewer starts, you can open the [Live Events 
Log] window to show all events that occurred within the 
last hour. The top row in the list shows item names. You 
can sort events in the list by clicking  in a column to 
specify the item to sort by and the sorting order.

Note
• Click [Window] > [Live Events Log] to display the [Live Events 

Log] window

• You can change the display priority for the [Live Events Log] 
window. For details, see “Configure Event Notification and 
Priorities” (p. 58).

Event Icon Colors

Different colored icons are displayed for events, 
depending on the priority.

Note
• You can change the event priority.

• Motion detection recording, sensor detection recording, 
intelligent function recording, and volume detection recording 
priorities can be specified when setting the recording mode of 
a recording schedule. (pp. 77, 78)

• Other event priorities can be specified when setting the 
Storage Server Group. (p. 42)

Acknowledging an Event

By default, when a [Highest] priority event is displayed in 
the [Live Events Log] window, an icon is displayed 
indicating that you should acknowledge the event.

The event will blink until you acknowledge it. Follow these 
steps to acknowledge the event.

User authentication settings are permanently 
disabled.

Note

You can disable event acknowledgement in [Viewer Settings]. 
You can also change the priority of events that need to be 
acknowledged. For details, see “Configure Event Notification and 
Priorities” (p. 58).

Check Events

Important
A maximum of 200 events can be displayed in the [Live Events 
Log] window.

Icon color Priority

Red Highest

Orange High

Yellow Medium

Light Green Low

Green Lowest

1 Click the event to be acknowledged in the [Live Events 
Log] window.

2 Click [Edit] > [Acknowledge Event].

Important
If [Show Video Window on Event] is enabled in [Viewer 
Settings], the corresponding video window is brought to the 
front automatically. The size of the video window is always 
[320x240] pixels.
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Search for Events

You can search past events and play back the event.

➀ [Description]
Enter the search criteria (event, camera, priority, 
camera tag, or host name).

➁ [When]
Specify the period in which the target event occurred 
([Today], [Last 2 Days], [This Week], [This Month], 
[This Year], and [All Dates]).

➂ [Search] and [Stop]
Start searching or stop a search in progress using 
these buttons.

➃ [Advanced Search]
Click to specify detailed search criteria.

➄ [Search Results]
Displays the search results.

➅ [Play Back Video]
Plays back the recording associated with the search 
results.

➆ [Close]
Close this panel.

Note

To display the [Event Search] dialog box when the toolbar is 
hidden, click [Search] on the timeline or click [Edit] > [Event 
Search].

Advanced Search

Click [Advanced Search] in the [Event Search] dialog box 
to specify detailed search criteria.

➀ [When]
Select [Specify Date Range] to specify the search 
period.

➁ [From] and [To]
Select [Specify Date Range] in [When] to specify the 
start and end times and dates for the search period.

➂ [Event]
Select the type of events to be searched.

➃ [Status]
Specify the status of the events ([All Statuses], [On], 
[Off]).

➄ [Priority]
Specify the priority of the events to be searched.

Play Back an Event

If a recording is associated with an event in the search 
results, right-click the event and click [Play Back Video] to 
play back the recording in the video window of the 
corresponding camera.
If the video window is not displayed, clicking [Play Back 
Video] will automatically display the window and start 
playback.

Note

Click [Live] in the timeline toolbar after playing in the video 
window to display the live view.

1 Click [Search] on the toolbar to display the [Event 
Search] dialog box.

2 Specify the search criteria.

3 Click [Search] to start searching.

➂
➀

➆➅

➄

➁
➃

➁
➂

➃

➀

➄
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Chapter 7
Operation and 
Management

❏  Error and warning level events

❏  How to check the status of the Storage Server

❏  Disk space management
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Events Indicating Errors or Warning Levels and Corresponding Actions

You can check events to determine if errors related to the Storage Server status have occurred.
When an event indicating an error or a warning level occurs, it is immediately displayed in the event panel or timeline. Take 
the appropriate action for the event.

*1 See “Disk Space Management (Important)” (p. 110).

Storage Server Health Check

Event Type Message Event Explanation Corresponding Action

Low disk space 
notification*1

Warning: Low disk space Occurs when the free disk space 
becomes less than the specified 
value, or the disk usage becomes 
greater than the specified value. Data 
may be deleted before the specified 
number of storage days has elapsed.

Check the recording mode 
settings (p. 76)

Starts/stops file deletion 
due to low disk space *1

Warning: Files deleted due to 
low disk space

Occurs when the free disk space 
becomes less than the threshold, or 
the disk usage becomes greater than 
the threshold.

Pauses/resumes recording 
due to low disk space *1

Recording Suspended
(Low Disk Space (<drive 
name>)

Occurs when the free disk space 
becomes less than the limit level, or 
the disk usage becomes greater than 
the limit level.

Error connecting to the 
camera

Error: Cannot Connect to 
Camera

Occurs on an error when connecting 
to the camera.

Check the network status.

Error connecting to the 
Storage Server

Error: Cannot Connect to the 
Storage Server

Occurs on an error when connecting 
to the Storage Server registered with 
the Storage Server Group.

Check the network status.

Error connecting to the 
Storage Server Group

Error: Cannot Connect to the 
Storage Server Group

Occurs on an error when connecting 
to the Storage Server Group.

Check the network status.

Change in the recording 
frame rate

Recording Frame Rate reduced 
at high load issues

Indicates that the recording frame 
rate has been changed due to 
increased server load.

Check the recording mode 
settings (p. 76).
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Status Bar

The status bar displays the Viewer processing status and 
load. You can check CPU usage to determine the load on 
your computer.
If the status bar is not displayed, you can display it by 
clicking [View] > [Status Bar].

System Information

To get the detailed video processing status of the Storage 
Server, click [Window] > [System Information] to display 
the [System Information] dialog box. If system operation is 
unstable or you are not able to record in the way you 
intended to, refer to Chapter 1 and reconsider the system 
configuration.
The [System Information] dialog box shows the status on 
three different tabs.

[Cameras] tab
This tab displays recording settings and processing 
information (camera tag, status, specified frame rate, 
actual frame rate, receiving bit rate, and recording bit 
rate) on the registered cameras.

[Storage Servers] tab
This tab displays information (Storage Server Group 
name, status, CPU usage, recording bit rate, and 
playback bit rate) on the registered Storage Server.

[Users] tab
This tab displays the users logged into the Viewer and 
related information (user group, host name (Viewer), 
Viewer version, host name (Storage Server), Storage 
Server Group Status).
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The Storage Server monitors the disk space and responds 
according to the amount of available space.

Action When the Low Remaining Disk Space 
Notification Level is Reached

The Storage Server issues an event when the disk space 
available for recording (i.e. available space relative to the 
maximum disk space used) goes below a certain level.
If [Maximum Disk Space Used] is not set, the drive 
capacity of the disk that stores the recording file is 
considered to be the maximum disk space.

Note

On receiving an event e-mail notification, an administrator can 
act promptly (for example, by removing unnecessary recording 
schedules) before a problem occurs due to low disk space.

Low Remaining Disk Space Notification Level 
Conditions and Calculation Method
If one of the following conditions is met, a low remaining 
disk space notification level is indicated.
Condition 1: If the Storage Server disk space usage 

exceeds the following values:
M x (100 - A)/100
(M: Value specified in [Maximum Disk Space 
Used], A: Value specified in [Low Disk Space 
Warning Level])
For example, if the value for [Maximum Disk Space 
Used] is 100 GB and the value for [Low Disk 
Space Warning Level] is 10%, the Storage Server 
reaches the low remaining disk space notification 
level when the Storage Server disk space usage 
becomes 90 GB or more.

Condition 2: If the free disk space falls below the 
following values:
Disk space x A/100
(A: Value specified in [Low Disk Space Warning 
Level])
For example, if the disk space is 80 GB and the 
value for [Low Disk Space Warning Level] is 10%, 
the Storage Server reaches the low remaining disk 
space notification level when the remaining free 
disk space becomes 8 GB or less.

Note

If other applications use the same hard disk, you need to 
consider condition 2. Even if the Storage Server uses a small 
amount of disk space, it may reach the low remaining disk space 
notification level according to condition 2 because other 
applications have consumed a portion of the disk space.

Calculation Example

Disk Space Management (Important)

Disk Space Status Explanation

Low remaining disk space 
notification level

You can specify a reference 
value using [Low Disk Space 
Warning Level] on the 
[Recording Settings] tab in 
the [Storage Server Group 
Settings] dialog box.

Threshold level The Storage Server calculates 
a reference value based on 
various conditions and 
settings.

Limit level

Important
An event e-mail notification is sent when the priority level of 
[Low Disk Space Warning] in the [Events] tab of the [Storage 
Server Group Settings] dialog box meets or exceeds the level 
specified in the e-mail notification settings. (p. 42).

<Drive Letter>
drive has low free disk 
space: Notification

Value for
[Maximum Disk

Space Used] Notification 
level

Notification

Disk Drive D Drive E Drive

Disk Space 100 GB 200 GB

Free Disk Space 50 GB 200 GB

Value for 
[Maximum Disk 
Space Used]

40 GB 200 GB

Value for Low 
Remaining Disk 
Space Notification 
Level

Condition 1:
40 GB x (100-10)/
100 = 36 GB     
Condition 2:
100 GB x 10/100 = 
10 GB

Condition 1:
200 GB x (100-10)/
100 = 180 GB     
Condition 2:
200 GB x 10/100 = 
20 GB
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Action When the Threshold Level is Reached

Recording continues, however, the Storage Server starts 
deleting recording files, beginning with old files, and 
issues an event.

Note
• Recording files are deleted, even if they have not reached the 

[Maximum Storage Period]. However, if the oldest file is 
currently in use by the Viewer (for example, for playback of 
recorded video), it will not be deleted and the next oldest file 
will be deleted instead. Deletion continues sequentially until 
the free disk space meets or exceeds the threshold again. For 
details on saving files, see Chapter 8.

• Normally, a recording file for which the minimum storage 
period has not elapsed is excluded from deletion. Note that 
such files are also deleted if the free disk space cannot meet 
and exceed the threshold value by deleting all the other files.

Threshold Level Conditions and Calculation Method
The threshold level is considered reached when the 
amount of free disk space drops below the following level.
(Number of cameras + 1) x 64 MB

Action When the Limit Level is Reached

The Storage Server stops recording and issues an event 
when the free disk space drops to this level.
The Storage Server resumes recording and issues an 
event when the free disk space increases above this level 
after deleting recording files.

Limit Level Conditions and Calculation Method
The limit level is considered reached when the amount of 
free disk space drops below 64 MB. This value is fixed.

Threshold 
level

Delete 
oldest first Notification

Deleting files on <Drive 
Letter> drive due to low 
free disk space: Started

Important

• The threshold level is to protect against reaching the limit 
level. We recommend that you take appropriate measures, 
such as deleting unnecessary recording data, when the 
event for the low remaining disk space notification level 
occurs.

• Storing recordings that cause the threshold level to be 
exceeded increases the load on the Storage Server and may 
cause recording to be interrupted, resulting in incomplete 
recordings. We strongly recommend that you operate the 
Storage Server at below the threshold level.

• If e-mail notification is specified, an e-mail message is sent 
for the event that occurs at each level (p. 42).

• Note that the threshold level conditions may be met before 
the low remaining disk space notification level conditions are 
satisfied, depending on the circumstances. For example, a 
large number of cameras with limited disk capacity may 
cause a value for (Numbers of cameras +1) x 64 MB to be 
larger than the value of disk capacity x low free disk space 
notification setting/100.

Deleting files on <Drive 
Letter> drive due to low 
free disk space: Started

Recording 
stopped 
notification

Delete 
oldest first Notification

Limit level



112



Chapter 8
Backup

❏  Types of backup target files and their destinations

❏  Restoring a recording file
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Destinations of the Backup Files

The data that is saved during a backup consists of 
recording data, event data, and configuration files. The 
data is backed up from the Storage Server and saved to 
the folders described below, on the drives that are 
specified in the drive settings (p. 46).

Recording Data

<Destination drive>:\Canon-NVR\videofiles
The following recording data file is backed up:

Images being recorded are saved to a temporary file on 
the hard disk. By default, a recording file is created and 
saved on the destination drive when the temporary file 
size reaches 1 GB. This size can be changed using the 
[Maximum File Size/Duration] option on the [Recording 
Settings] tab in the [Storage Server Group Settings] dialog 
box (p. 41).

Note

• Greenwich Mean Time is used for the time added to the file 
name of the recording data.

• This software uses lossy compression for the recording data. 
You do not need to compress the recording files further using a 
tape drive or other devices.

Temporary Files
The following is a temporary file, before it is made into a 
recording data file by the system. This file cannot be 
backed up using the standard backup method.

Event Data

<Destination drive>:\Canon-NVR\eventfiles
The following event data file is backed up:

Note
Greenwich Mean Time is used for the time added to the file name 
of the recording data.

Configuration Files

The settings for the Storage Server and the Viewer are 
saved in the following folders on the computer where the 
program is installed. You must back up all of these folders 
to completely back up the configuration files.

Configuration file path
<System drive>:\ProgramData\Canon\WebView\NVR30\
<System drive>:\Users\<user name>\AppData\Local\
Canon\WebView\NVR30\

Note

• The configuration file names are not displayed unless [Show 
hidden files and folders] is selected in the [View] tab of 
Windows Explorer [Folder Options].

• You cannot use the shadow backup feature.

Notes on Backup

• You do not need to stop recording to back up recorded data 
that is complete. However, the frame rate may change 
because of increased disk I/O load and/or CPU load.

• If you want to restore a backed-up recording file, the computer 
you restore the backup to must have the same drive 
configuration as the original Storage Server. For example, if the 
original Storage Server includes a system drive and a 
recorded data drive, the Storage Server you restore the 
backup to must also have a system drive and a recorded data 
drive. Determine the hard disk capacity based on the volume 
of data to be restored.

Backing up data

NVR3_MEDIA_ xxxxxxxx _ yyyymmdd _ hhmmss .edt
Camera ID Year, month 

and day when 
recording 
started

Time

NVR3_UNINDEXED_MEDIA_xxxxxxxx_ yyyymmdd _hhmmss.edt
Camera ID Year, month and 

day when 
recording started

Time

NVR3_EVENT_ xxxxxxxx _ yyyymmdd _hhmmss.edt
Camera ID Year, month 

and day when 
recording 
started

Time
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Restoring from Backup Data

Use the following procedure to restore a Storage Server 
from backup data:

The new Storage Server must have the same drive 
configuration as the original Storage Server.

See “Stopping the Storage Server”(p. 115) for details 
on how to stop the Storage Server.

The following folder is used by default:
Configuration file path
<System drive>:\ProgramData\Canon\WebView\
NVR30\
<System drive>:\Users\<user name>\AppData\Local\
Canon\WebView\NVR30\

The following folder is used by default:
<Destination drive>:\Canon-NVR\videofiles\

The following folder is used by default:
<Destination drive>:\Canon-NVR\eventfiles\

Stopping the Storage Server

The Storage Server runs in the background as a Windows 
service. When you restore backup data, you must follow 
the following steps to temporarily stop the Storage Server.

Double-click [RM-Lite Storage Server].

Note

To restart the Storage Server, follow the same steps and click 
[Start] in step 6.

How to Restore a Backup

1 Prepare a new Storage Server for the restore.

2 Install this software.

3 Stop the Storage Server.

4 Restore the configuration file for this software to its 
original location.

5 Restore the recording files to their original location.

6 Restore the event files to their original location.

7 Start the Storage Server.

8 Make sure that recording is performed correctly. Also 
make sure that the restored recording data plays back 
correctly.

Important

If the [Ensure video is kept for upto] option is set on the 
[Servers] tab in the [Settings] dialog box, any restored 
recording data that exceeds the specified storage period will 
be deleted when the Storage Server starts.

1 Click [Start] > [Control Panel].

2 Click [System and Security].

3 Click [Administrative Tools].

4 Double-click [Services].

5 Double-click [RM Storage Server] to display [RM 
Storage Server Properties].

6 Click [Stop].

7 Click [OK] to close the properties.
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Chapter 9
Troubleshooting

❏ Actions required when recording errors occur

❏ Solutions when Viewer problems occur

❏ Error messages
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When a recording error occurs (e.g., data is missing) during playback, you can troubleshoot the cause by checking the 
information in the event log and the Storage Server log file.

If you encounter problems when you use the Viewer, refer to the following solutions:

Viewer and Video windows

Actions Required When Recording Errors Occur

Log
Cause Action

Event Storage Server

Error: Cannot Connect to 
Camera

CameraServer <host name> 
disconnected(<error 
information>)

A network error may have 
occurred. Look for the cause of 
the error by checking the 
Winsock error code recorded in 
the Storage Server log (p. 126).

Check the network (hub, cables, 
etc.) for any problems and make 
sure that the camera is 
operating normally.

Recording Frame Rate reduced 
due to high load issues

— • The effective recording rate is 
excessively low (50% or 
lower).

• Sensor and motion detection 
events may have been issued 
too frequently.

• The load on the Storage 
Server CPU may be high.

• Modify the recording 
schedule and the motion 
detection sensitivity.

• Check the current CPU usage 
and terminate any 
applications that are a heavy 
load on the CPU.

Recording Suspended
(Low Disk Space (<drive 
name>))

— The load from writing recorded 
data to the hard disk may be too 
high.

Shorten the maximum storage 
period or consider adding a 
hard disk. Additionally, try to 
modify the recording schedule.

Solutions When Viewer Problems Occur

Problem Solution

I cannot use the pan, tilt or zoom feature of the 
camera in the video window.

• Double-click the video window or click [Control] on the [Camera Control] panel 
(p. 100).

• If images are being played (the title bar of the video window is gray), you cannot 
operate the camera. Click [Live] on the timeline and get control of the camera.

When I click a video window to display the 
[Video Window] menu, [Record Now] is gray 
(unavailable). But, I can use the feature in 
another video window.

Display [<camera name> Properties] for the video window and check on the 
[Advanced] tab whether the camera is disabled. If the camera is disabled, click 
[Enable Camera]. (p. 49).

When I try to use layouts created by other users, 
the [Layout] menu is not displayed. I cannot 
select a layout.

Layouts saved in the [User Layouts] folder cannot be seen by other users.
To allow all users to access layouts created by a user, the layouts must be created by 
a user with administrator permissions and must be saved in the [Shared Layouts] 
folder (p. 65).

The quality of images (live and recorded) in the 
video window is low.

Change the receive size and display size settings. Depending on the receive size 
and display size, the image quality may decrease. For example, if video with a low 
receive size is displayed on a large video window, the image quality will decrease. 
You can adjust the quality for recorded images with the advanced recording settings.

None of the cameras will record. • Is the network cable for the server properly connected?
• Has there been a power failure?
• Is “Do not Record” specified for a special day schedule?
• If link lamps on the hub (switching hub) and on the network connector on the 

server do not light, there may be a defect in the server’s cable, hub (switch), or 
network connector.
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Some cameras do not record. • Is the power and the network connection for the cameras working?
• Do the cameras reply to a ping?
• Can you view live images on the Viewer for the cameras?
• Is “Do not Record” specified for a special day schedule?
• Is sensor recording or motion detection recording set?

I cannot connect to the Storage Server from the 
Viewer.

• Are the login user name and password correct?
• Is the network connection between the server and the Viewer working?
• Is the IP address of the destination server correct?
• Does the server reply to a ping from the Viewer computer?
• Is TCP port 80 being used by another application?

I cannot view live images. • If “Could not connect to camera” is displayed in the video window, check the 
camera’s power supply and network connection.

• If a message is displayed in the timeline of the Viewer indicating that an error 
occurred when connecting to the camera, check the camera’s power supply and 
network connection.

• If the screen goes blank when the layout is switched, but a video is displayed after 
a few seconds, the number of cameras or the live frame rate setting exceeds the 
performance capabilities of your computer. Reduce the number of cameras, or 
decrease the frame rate.

The Storage Server slows down or it takes longer 
to perform various configuration changes, such 
as registering cameras or recording schedules 
from the Viewer. (for Windows Vista)

• Make sure that less than 10 cameras are registered on each Storage Server.
• If the Storage Server is running Windows Vista, use Windows Server 2008 instead.

Live images are no longer displayed from any 
camera. (for Windows Vista)

• Make sure that less than 10 cameras are connected to one Viewer.
• If you are using the layout sequence feature, set the interval to 20 seconds or 

longer.
• If the Storage Server is running on Windows Vista, switch to Windows Server 2008.

When the layout sequence feature is used, the 
video windows suddenly go blank and the 
image from the cameras can no longer be 
displayed.

When you use the layout sequence feature to switch quickly to a layout where there 
are a large number of video windows, the communication resources of the system 
may become insufficient. Reduce the number of cameras in a layout, or make the 
display interval for the layout sequence longer.

The Viewer slows down. • The performance of the Viewer depends largely on the specification of your CPU 
and graphics card. When the Viewer seems to slow down, try to reduce the 
number of cameras in the Viewer or decrease the frame rate.

• If the video size or quality setting for the cameras is high, the large amount of 
image data may cause processing to take longer. Try adjusting the video quality 
and video size settings on the camera.

Problem Solution
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Timeline

[Extract Video]

Recording

Connection Problems

Problem Solution

Nothing happens when I click any of the 
playback controls.

• Move the playhead off of the [Live] position.
• You must select a video window before you can play back images. In addition, the 

previous frame and next frame buttons (p. 98) and the [Extract] button (p. 99) are 
enabled only when one video window is selected.

Problem Solution

I tried to save a recording, but an error message 
is displayed telling me that no video can be 
found in the selected timeline segment.

Make sure that a recorded image is included in the selected portion of the timeline 
(p. 97).

Problem Solution

The [Record Now] feature cannot be used. Make sure that the camera is not disabled on the [Advanced] tab in [<camera name> 
Properties]. If the camera is disabled, click [Enable Camera] (p. 49).

The amount of Storage Server disk space usage 
is much higher than the calculated level (pp. 22, 
110) and free disk space is low.

When the video size or quality setting of the camera is high, the amount of data per 
frame is large. In addition, if you are using anti-virus software, the software records 
communication between the Storage Servers and the cameras and the size of that log 
may reach several gigabytes. Change the anti-virus software settings to exclude the 
Storage Servers from the target list.

Problem Solution

The screen goes blank and the “Cannot connect 
to camera” message is displayed.

A network error occurred, the camera was disconnected from the network, or the 
camera power was turned off.
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Messages Displayed in the Viewer

Error Messages in the Video Window

Error Messages

Message Cause

Video window Connecting to camera. The Viewer is in the process of connecting to the 
camera.

Cannot connect to camera. The Viewer cannot connect to the camera and live 
images cannot be displayed.

Getting camera control. Displayed after the user tries to get camera control.

Cannot get camera control. Another user with higher priority is already 
controlling the camera when you try to get camera 
control.

Control will be lost in <count down> seconds. Displayed if the camera is idle for one minute; 
starts a countdown. The countdown starts at 10 
and counts down one second at a time until it 
reaches zero.

Camera control lost. A timeout occurred while the Viewer was 
controlling the camera or another user with higher 
priority requested camera control. Displayed for 
three seconds.

No recorded video. Displayed when playing back a recording if there 
is no recorded image at the current playhead 
position. 

Cannot Connect to the Storage Server. Displayed when you cannot connect to the Storage 
Server to play back a recording.

Please wait. Displayed when it may take some time to display 
an MPEG-4 or H.264 live/recorded image.

Could not connect to send audio. A connection for sending audio to the camera 
could not be established, so audio cannot be sent 
to the camera.

Could not connect to receive audio. A connection for receiving audio from the camera 
could not be established, so audio cannot be 
received from the camera.

You do not have permission to view the live video. The administrator has prohibited the display of live 
view.
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Warning Messages in the Viewer

Confirmation Messages in the Viewer

Message Cause

Event notification Invalid E-mail Address. Characters other than alphanumeric characters 
and the underscore (_) were entered for the e-mail 
address.

The SMTP server port is invalid. Please specify a 
value between 1 and 65535.

An invalid SMTP server port number was entered. 

The POP server port is invalid. Please specify a 
value between 1 and 65535.

An invalid POP server port number was entered.

User management The user name already exists. Tried adding a user to the Storage Server with a 
name that already exists.

Unable to change the user name. The user '<user 
name>' already exists.

Tried adding a user name on the Storage Server to 
a name that already exists.

Please ensure that the password and confirmation 
match exactly.

The password in the [Confirm Password] field does 
not match the user password.

Are you sure you want to remove this user? Tried to delete a user.

The number of connecting viewers has exceeded 
the recommended number, and the recording 
server is under high load.

Tried connecting 7 or more Viewers at one time.

Configuration The value for maximum must be greater than or 
equal to 1 day.

Tried to specify less than one day for the maximum 
storage period.

Adding a recording schedule Streaming for recording is applied only when the 
following conditions are satisfied:
– the video stream format is JPEG
– the frame rate settings do not exceed 10 fps
– there is no existing recording-mode stream in 

the camera.

Tried to enable a recording-mode stream.

Message Cause

Adding and editing a camera Are you sure you want to remove the camera 
'<camera name>'? If the camera is removed, you 
will not be able to play back recorded video.

Tried to delete the camera.

Viewer window This will replace an existing layout of the same 
name. Are you sure you want to continue?

Tried to save the current layout with a name that 
already exists.

Managing a layout This layout is included in a layout sequence open 
in another tab or window. Are you sure you want to 
continue?

Tried to change and save settings for a layout 
included in a sequence that is open in another tab 
or window.

Are you sure you want to delete the selected layout 
'<layout name>'? 

Tried to delete a layout.

Are you sure you want to delete the folder '<folder 
name>';  including all layouts and layout 
sequences inside it? 

Tried to delete a layout folder.

Shared layout sequences cannot contain personal 
layouts. All of the personal layouts will be 
automatically removed from this layout sequence. 
Are you sure you want to continue?

Tried adding a user layout to a shared layout 
sequence.

Are you sure you want to delete layout sequence 
<layout sequence name>?

Tried to delete a layout sequence.
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Error Messages in the Viewer

Message Cause

Recording schedules This schedule item overlaps a previously 
scheduled item. Please check your settings and try 
again.

Recording schedules overlap.

Recording schedule items must be set at least 15 
minutes long. Please check your settings and try 
again.

Tried to set a schedule with a period shorter than 
15 minutes.

Recording schedule items cannot be created for 
the following cameras because of a clash with 
existing schedules:  <camera name>

Tried to drag a recording schedule window to add 
multiple recording schedules, but one camera has 
a conflicting schedule.

Failed to create multiple recording schedule items. 
All selected cameras have recording schedule 
items that clash with a schedule time range.

Tried to add a recording schedule to multiple 
cameras using the [Edit Schedule Item] dialog 
box, but the schedule time range clashes with 
schedules that are already set on the cameras.

At least one day must be selected. Please check 
your settings and try again.

[OK] was clicked without specifying the day of the 
week.

At least one recording mode must be selected. 
Please check your settings and try again.

[OK] was clicked without selecting the check box 
for a recording mode.

You cannot use digital zoom with “Current Camera 
Position”.

Tried to specify the electronic zoom range for the 
VB-C60 or VB-M40 and close the [Edit Schedule 
Item] dialog box with [Current Camera Position] 
selected.

Special day schedules This schedule type has days set up for it to be 
used on. These need to be removed before 
deleting the schedule type.

Tried to delete the special day schedule that has 
scheduled days.

This day has already been set as special day 
schedule '<schedule name>'. Do you want to 
delete the day from the special day schedule 
'<schedule name>' and use it in this schedule?

Tried to use dates that are already used for another 
special day schedule.

Special day schedules cannot be set the end time 
which is earlier than the start time.

Tried to register a schedule that goes past 24:00.

A schedule with this name already exists. Tried to add a special day schedule with a name 
that already exists.

Viewer window Communication with the SSG “<storage server 
group name>” has failed. To ensure that event and 
video data are available from this SSG, identify and 
resolve the problem and then press [OK] to 
reconnect to the SSG. If you press [Cancel], then 
some event data including all future events for 
cameras recording to this SSG will not be 
available.

A problem occurred when connecting to the 
Storage Server to display a Viewer window.

Do you want to save changes to this layout? Tried to close a layout that was modified.

Cannot save it in this folder. The Windows folder or the Program Files folder 
was specified as the destination folder for 
snapshots.

This will replace an existing layout of the same 
name. Are you sure you want to continue?

Tried to save a layout sequence to a folder that 
contains a layout or a layout sequence with the 
same name.

This layout cannot be saved using the same name 
as an open layout. Please try again using a 
different name.

Tried to save a layout using the same name as 
another layout that is open in another tab or 
window.

Adding and editing a camera Could not connect to camera. Please verify that the 
host name, port number, user name and password 
are correct.

Could not connect to the camera.

Are you sure you want to remove the camera 
'<camera name>'? If the camera is removed, you 
will not be able to play back recorded video.

Tried to delete a camera.
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Saving the specified image The length of the extracted video must not exceed 
1 hour.

Tried to make the time longer than 1 hour.

Unable to extract video. There is no video data in 
the specified timeframe.

Could not save an image because there was no 
recorded image in the selected segment.

Cannot save it in this folder. The Windows folder or the Program Files folder 
was specified as the destination folder for a .mov 
file.

[Organize Layouts and 
Layout Sequences] dialog 
box

You cannot move the layout <layout name> 
because it is contained in the current layout 
sequence.

Tried to move a layout that is registered to the 
layout sequence currently in use.

You cannot move the layout '<layout name>' 
because it is the current layout.

Tried to move the current layout.

You cannot delete the layout <layout name> 
because it is the current layout.

Tried to delete the folder that contains the current 
layout or the current layout and layout sequence.

Unable to change layout name. The name <layout 
name> already exists.

Tried to rename a layout using the same name as 
an existing layout.

You cannot move the layout sequence <layout 
sequence name> because it is the current layout 
sequence.

Tried to move a layout that is registered to the 
layout sequence currently in use.

You cannot delete '<layout name>' because it is 
used by the current layout sequence.

Tried to delete a layout that is part of the current 
layout sequence.

You cannot delete the layout sequence '<layout 
sequence name>' because it is the current layout 
sequence. 

Tried to delete the current layout sequence.

You cannot move the folder <folder name> 
because it contains an open layout sequence.

Tried to move the folder that contains the layout 
sequence currently in use.

You cannot move the folder <folder name> 
because it contains an open layout.

Tried to move the folder that contains the current 
layout.

You cannot delete the folder <folder name> 
because it contains the current layout.

Tried to delete the folder that contains the current 
layout.

Unable to create folder. The name <folder name> 
already exists.

Tried to create a new folder using the same name 
as an existing folder.

Unable to change layout folder name. The <folder 
name> already exists.

Tried to rename a folder using the same name as 
an existing folder.

You cannot move <folder name> folder because it 
contains layout <layout name> used by layout 
sequence <layout sequence name> which is 
open.

Tried to move a folder that contains a layout 
registered to the current layout sequence.

You cannot delete <folder name> folder because it 
contains layout <layout name> used by layout 
sequence <layout sequence name> which is 
open.

Tried to delete a folder that contains a layout 
registered to the current layout sequence.

Message Cause
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Messages Recorded in the Log Files

Log File Locations
The Storage Server log files are saved in the following folder on the computer where the server is installed.
<System drive>:\ProgramData\Canon\WebView\NVR30\Log\

Types of Log Files

Error Message List
Messages shown below are recorded in the log file when an error occurs.

File Name Explanation

storage_server_log_0.csv Log file for the Storage Server

viewer_log_0.csv Log file for the Viewer

Message Explanation

Cannot rename storage_server.cfg.tmp to storage_server.cfg file A temporary file for the configuration file was found, but could not 
be renamed.

No configuration file found. Could not find the Storage Server configuration file.

Cannot delete old config '<file name>', error code <win32 error> Could not save the configuration.

Cannot rename config from '<temporary file>' to 
'storage_server.cfg', error code <win32 error>

Could not save the configuration.

Cannot write to config '{storage server name} Could not save the configuration.

Configuration file failed consistency check, exiting... Inconsistency was found in the configuration file. This occurs when 
the configuration file is rewritten directly.

Error: Local machine not in the config. Could not find the IP address or host name of the Storage Server in 
the configuration file.

Failed to bind to listen port {port number} The Storage Server could not bind to the port.

Failed to setsockopt for conditional accept() Could not apply a socket option to the socket for group 
communication.

LS_start_service(apache) failed. Apache startup failed.

Email Authentication error (<reason>): <host> An authentication error occurred while sending e-mail.

Email error: recipient is unreachable (<reason>): <host> A transmission error occurred while sending e-mail.

Email error: server not responding (<reason>): <host> Could not communicate with the SMTP host while sending e-mail.

Unable to obtain file size on disk, GetFileAttributesEx failed with 
error=%d for file %S

Could not determine the size of the media or event file.

CameraServer <host name> disconnected(<error information>) Could not connect to the camera.



126

Error Codes

Winsock Error Codes

SMTP Error Codes

Code Error Message Possible Cause

10038 An operation was attempted on something that is not a 
socket.

This may occasionally occur. No action is required.

10048 Only one usage of each socket address (protocol/network 
address/port) is normally permitted.

All communication resources are in use. This error is 
frequently reported when a video can no longer be displayed 
in a Viewer layout sequence.

10050 A socket operation encountered a dead network. Occurs when the computer recognizes that the network is 
down because the router or hub closest to the computer is 
powered off. Normally, this cannot be recognized, therefore 
this error is rarely reported.

10051 A socket operation was attempted to an unreachable 
network.

Occurs when other network devices recognize that the 
network is down because the router or hub is powered off. 
Normally, this cannot be recognized, therefore this error is 
rarely reported.

10054 An existing connection was forcibly closed by the remote 
host.

The connection was aborted by the camera due to a camera 
restart or other causes. This may occur when the camera is 
restarted using the restart button on the Setting Page 
provided by the camera software. However, this rarely 
occurs.

10060 A connection attempt failed because the connected party 
did not properly respond after a period of time, or 
established connection failed because connected host has 
failed to respond.

A timeout occurred in the TCP connection with the camera. 
This occurs when the camera is powered off.

10061 No connection could be made because the target machine 
actively refused it.

The camera rejected the TCP connection. This occurs when 
the port number is incorrect or from another cause.

10064 A socket operation failed because the destination host was 
down.

Occurs when the camera is powered off. Normally, 10060 
occurs.

10065 A socket operation was attempted to an unreachable host. There is no route for connecting to the camera. This may also 
occur when there is a failure in the network cable connected 
to the computer or hub.

10091 WSAStartup cannot function at this time because the 
underlying system it uses to provide network services is 
currently unavailable.

There is a failure on the computer’s network adapter.

11001 No such host is known. The host name could not be resolved in the DNS.

11004 The requested name is valid, but no data of the requested 
type was found.

The host name could not be resolved in the DNS.

Code Error Message Possible Cause

421 <domain> Service not available, closing transmission 
channel

The communication was terminated because the mail server 
was stopped.

450 Requested mail action not taken: mailbox unavailable The requested mail processing was not performed because 
the mailbox is not available.

451 Requested action aborted: local error in processing The requested operation was canceled because an error 
occurred in the mail server.

502 Command not implemented The mail server does not support the command that was 
sent.

550 Requested action not taken: mailbox unavailable The request was not executed because the mailbox is not 
available.
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HTTP Error Codes

wininet Error Codes

POP Error Messages

Code Error Message Possible Cause

401 Unauthorized The user name and password for connecting to the camera 
is incorrect.

403 Forbidden A connection cannot be established due to an IP address 
restriction on the camera. This may also be returned by a 
proxy server.

500 Internal Server Error Occurs when the HTTP server is running but the Storage 
Server is not started. It may also occur during normal 
operation if the camera is restarted.

503 Service Unavailable Occurs when the camera is temporarily unable to process 
requests due to server overload (excessive requests from 
multiple clients), or an uncompleted start-up process on the 
camera, or other reasons.

Code Error Message Possible Cause

12002 The request has timed out. A request timeout occurred. Indicates that the connection or 
request transmission failed.

12005 The URL is invalid. The URL is incorrect. Normally, this does not occur, however, 
it may occur when an attempt is made to connect to an 
unsupported camera.

12007 The server name could not be resolved. The host name could not be resolved. This error is generated 
when a host name that is not registered in the DNS is 
specified or when a problem occurred in communication with 
the DNS itself.

12017 The operation was canceled, usually because the handle on 
which the request was operating was closed before the 
operation completed.

The communication was canceled. This error does not 
indicate a problem and may be generated during normal 
operation.

12029 The attempt to connect to the server failed. The connection to the camera failed. Normally 12002 is 
generated.

12030 The connection with the server has been terminated. The connection to the camera has been aborted. The 
disconnect process itself is recorded when it executes 
normally.

12031 The connection with the server has been reset. The connection to the camera has been reset.

Error Message Possible Cause

ERR never heard of mailbox name The e-mail address is incorrect.

ERR invalid password The password is incorrect.

ERR unable to lock maildrop The mailbox cannot be used. It is already in use by another program.
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Event Information

Event Information Displayed Message

Motion Detection [Motion On] or [Motion Off]

Sensor Recording [Sensor On] or [Sensor Off]

Record Now [Manual Recording Started] or [Manual Recording Stopped]

Intelligent Function [Intelligent Function On] or [Intelligent Function Off]

Volume Detection [Volume Detection On] or [Volume Detection Off]

Recording [Recording Started] or [Recording Stopped]

Change in the recording frame rate [Recording Frame Rate reduced due to high load issues] or [Reverted to the 
Recording Frame Rate due to resolution of high load issues]

Low Disk Space Warning [Warning: Files deleted due to low disk space]

Delete recorded files (when disk space is insufficient) [Delete recorded files (when disk space is insufficient) started] or [Delete 
recorded files (when disk space is insufficient) stopped]

Delete recorded files (when disk space is low) [Delete recorded files (when disk space is low) started] or [Delete recorded files 
(when disk space is low) stopped]

Suspending/Resuming Recording [Recording Suspended] or [Fixed: Recording Resumed]

Camera Communications Error [Error: Cannot Connect to Camera] or [Connection to Camera Fixed] 

Storage Server Starting/Stopping [Storage Server Started] or [Storage Server Stopped]
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You can configure the way the Viewer starts up, for 
example, to have it bypass the login screen with the user 
name and password (pp. 39, 40) by creating a shortcut 
icon that specifies Viewer startup options.

[Viewer.exe] is located in the following folder by 
default:
<System drive>:\Program Files\Canon\WebView\NVR
A dialog box asking whether to create a shortcut on 
the desktop is displayed.

Note

<System drive> corresponds to the drive containing the system 
files of the operating system. If the operating system is installed 
on the C drive, the system drive is the C drive.

About the Latest Camera Firmware

You can find the latest firmware and configuration backup 
and restore tools for cameras that are supported by this 
program at the Canon Web site.

Update the Firmware

To update the firmware for your camera, you must use the 
tool that is specific to your camera model.

Note
If the firmware update fails, restore the configuration using the 
Restore Tool.

Create a Shortcut Icon for Starting the Viewer

Important

• You cannot reconfigure the shortcut icon that is automatically 
created on your desktop when you install this software.

• The login password can be easily viewed in the properties of 
the shortcut icon. Make sure to take sufficient security 
measures when using this feature.

1 Right-click [Viewer.exe] in the installation folder and 
click [Create shortcut].

2 Click [OK].

3 Right-click the shortcut icon that was created on the 
desktop and select [Properties].

4 On the [Shortcut] tab, add a startup option to [Target].

Startup Options Description

-group nvr://
<username>:<password>@<
storage server group name>

The information in the options 
is used to connect to the 
server group and start the 
Viewer, without displaying the 
[Connect to Storage Server 
Group] dialog box on startup.

5 Click [OK] to close the dialog box.

Camera Maintenance

1 Download the latest firmware with the Firmware 
Upgrade Tool, and download the Backup Tool and 
Restore Tool.

2 Back up the camera configuration using the Backup 
Tool.

3 Update the firmware using the Firmware Upgrade 
Tool.
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The steps below explain how to check the version of this 
software.

Checking the Version of the Viewer

Checking the Version of the Storage Server

The VB-C60, VB-C500D, and VB-C500VD support 
MPEG-4 format, while the VB-M40, VB-M600D, VB-C600V 
and VB-C700F support the H.264 format. Note that the 
following limitations apply.

Live View
• The following video window settings cannot be set, and 

the frame rate settings on the camera are enabled.
– Maximum Frame Rate
– Auto Adjust Frame Rate

• Synchronization of audio and video is not guaranteed.

Recording
• The frame rate for the following recording modes 

cannot be set, and the frame rate settings on the 
camera are enabled.
– Continuous recording
– Motion detection recording
– Sensor recording

• The [Reduce recording frame rate when disk is under 
high load] setting in the Storage Server Group Settings 
is disabled.

• The [Record Now] option only supports JPEG format. 
You cannot use this option to record video in MPEG-4 
format or H.264 format.

Playback
• You can perform the following operations. However, 

you cannot use [Rewind] and [Previous Frame].
– Specify the playback time on the timeline
– Start playback from the live event display window 

and the event search window
– You can use [Pause], [Fast Forward], [Next Frame], 

[Previous Event], and [Next Event]
• If you change the recording format of a recording 

schedule from MPEG-4 or H.264 to JPEG part of the 
way through the recording, then when you rewind the 
recording, the image disappears when you transition 
from the JPEG segment to the MPEG-4 or H.264 
segment, and the “No Recorded Video” error message 
is displayed.

• Recordings in MPEG-4 and H.264 format recorded with 
this software can only be played back with this 
software. However, you can use [Extract Video] to save 
the recording as a .mov file and use QuickTime or other 
compatible software to play back the recording.

How to Check the Version

1 Start the Viewer.

2 Click [Help] > [About].

3 Check the version of the software on the displayed 
dialog box.

1 Click the Start button > [Control Panel] > [Uninstall a 
program] or [Add or Remove Programs].

2 Check the version of the software in the displayed list.

Functional Limitations for MPEG-4 and H.264 formats
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For setting details for the AXIS Q7404/Q7401, see the user manuals and safety precaution manuals includied with each 
product.

Supported Firmware

The following firmware is necessary when using the AXIS Q7404/Q7401.

Usage Precautions

• When registering the AXIS Q7404/Q7401 in RM-64/25/9, you must enter the host name, and the Administrator group 
account user name and password just as with other cameras.

• Register one AXIS Q7404/Q7401 at a time. You cannot search and register them.
• If the number of simultaneous accesses to the AXIS Q7404/Q7401 increases, it may affect the recording or live video 

frame rates. Be sure to test sufficiently before beginning operation.
• A maximum of 20 clients can connect to the AXIS Q7404/Q7401. If the number of connecting clients exceeds 20, a 

message stating you cannot connect to a camera will appear when you try to open an RM-64/25/9 video window.
• If the AXIS Q7404/Q7401 is not connected to a camera, or if the input signal is lost, such as an interruption of the camera 

connection, [NO VIDEO] will appear on the screen of RM-64/25/9.
• Video size and image quality cannot be set with RM-64/25/9. Available video sizes are 160 x 120, 320 x 240, and 

640 x 480.
• If [Aspect ratio correction] is not selected in the AXIS Q7404/Q7401’s [Image] tab of the [Video Stream Settings], the 

displayed video will be slightly compressed horizontally. We recommend that you select [Aspect ratio correction].
• Reboot the AXIS Q7404/Q7401 if you use it to change settings.

Functional Limitations

The following limitations apply to the  AXIS Q7404/Q7401 when using RM-64/25/9.

Recording Schedule and Recording Mode Settings
• Only continuous recording can be used.
• The following functions are disabled in the [Edit Schedule Item]  dialog box.

– [Record audio if available]
– [Advanced]
– [Use the recording-mode stream]

Frame Rate
• The AXIS Q7404/Q7401 frame rate setting has no effect on the recording frame rate or live frame rate settings of RM-64/

25/9. Set the frame rate with RM-64/25/9. Only integer values for the frame rate are available in this case (minimum 1 fps).
• When four cameras are connected, you may not be able to record or play back video at the maximum frame rate 

(30 fps).

Auto Adjust Frame Rate Function
Regardless of the RM-64/25/9’s setting in [Auto adjust frame rate under heavy load] in [Viewer Settings], the Auto adjust 
frame rate function is always not available.

Using the AXIS Q7404/Q7401

Video Encoder Firmware

AXIS Q7404 Ver.5.20

AXIS Q7401 Ver.5.20.2
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Video Format
Only JPEG is available for recording or live view.

Camera Limitations
• Even if a camera has pan/tilt/zoom functions, they cannot be operated via the RM-64/25/9 control panel if the camera is 

connected to an AXIS Q7404/Q7401.
• The control panel’s [Presets] is disabled.

Audio
• Audio input/output is not supported.
• Even if you select the AXIS Q7404/Q7401’s video window, the audio panel will be disabled.

Text Overlay Settings
The AXIS Q7404/Q7401 text overlay settings (date, time, text, image in video display) cannot be set with RM-64/25/9. In 
addition, the text overlay settings time display and RM-64/25/9’s time display are not synchronized.

Sensor Input Terminal
The input terminals for the AXIS Q7404/Q7401 cannot be used.
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